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ABSTRACT 

 

Significant accumulations of lower Wilcox Group coals have previously been reported 

throughout regional reconnaissance studies in north-central Louisiana. The present study is 

part of a series of contiguous sub-regional studies that incorporate much higher well 

densities, evaluate each well log individually for coal presence, and map the structures and 

thicknesses of the Reynolds and the Russell coal. The thickest coal accumulations are found 

in paralic lagoon deposits in the northern portions of the study area within Lasalle and 

Rapides Parishes just south of the Angelina-Caldwell Flexure and ontop of the LaSalle Arch. 

No lower Wilcox Group coals were found south of Township 2N (latitude 31.100° N) in this 

study. Lower Wilcox Group strata south of Township 2N are interpreted as a shoreline with 

marine conditions to the south, not suitable for coal accumulation.  
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INTRODUCTION 

     Background 

The U.S. Energy Information Administration (EIA) recently released the International 

Energy Outlook 2013 (IEO2013) Figure 1 that projects world energy consumption will grow 

by 56% between 2010 and 2040, from 524 quadrillion British thermal units (Btu) to 820 

quadrillion Btu (EIA, 2013). Most of this growth will come from non-Organization for 

Economic Cooperation and Development (non-OECD) countries, where demand is driven by 

strong economic growth (EIA, 2013). Renewable energy and nuclear power are the world's 

fastest-growing energy sources, each increasing 2.5% per year. However, fossil fuels were 

predicted to continue to supply nearly 80% of world energy use through 2040 (EIA, 2013).  

Natural gas is the fastest-growing fossil fuel, as global supplies of tight gas, shale gas, and 

coalbed methane (CBM) increase.  

 

Figure 1: Model of world consumption of energy to 2040 (EIA, 2013). 
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Production of coalbed methane in Louisiana is minimal compared with that of other 

comparable basins throughout the U.S. Other basins such as the San Juan basin of New 

Mexico and Colorado, Black Warrior basin of Alabama, and the Powder River Basin of 

Wyoming and Montana account for 7.3% of the U.S natural gas production in 2011 (EIA, 

2013). Natural gas from coal-rich basins such as those found in the United States, is 

comprised mainly of methane (CH4) and is one of the cleanest burning fossil fuels. This 

readily accessible resource is significant, particularly because the country is persistently 

searching for alternative energy resources to assist in decreasing dependency on foreign 

energies.            

 Coalbed methane production has been established in a number of basins in the U.S. 

since the late 1980s, the graph in Figure 2 shows the increase in coalbed methane production 

from 1990-2012. 
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Figure 2: U.S. coalbed methane production from 1990-2012 (U.S. Energy Information 

Administration, 2013). 

   The bulk of CBM production has been from Paleozoic coals in the east and from 

younger, thicker coals in the west; however, very limited drilling activity has been conducted 

in the Gulf Coast Tertiary basin to define the coalbed methane resource specifically (Breland, 

2004). The quality, burial depth, and age of the Gulf Coast coals have generally been 

considered negative contributing factors in the possible development of this resource. Likely 

estimates of coalbed methane resources within the U.S. are broken down by basin in Figure 3 

by basin.   
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Figure 3: U.S. coalbed methane resources (U.S. Energy Information Administration, 

2007). 

 

The first coalbed methane well drilled in Louisiana was completed by Torch 

Operating Company in 1989. The #3 Greer well was producing 50 million cubic feet per day 

(MCFD), and it was later plugged and abandoned (Breland, 2004). Data available from 

several wells completed in Wilcox Group coals in the north-central part of the state have 

production rates ranging from 7 to 122 MCFD and associated water production of up to 550 

barrels of water per day (BWPD)  
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(Warwick et al., 2004b).  By far the best examples of coalbed methane production in 

Louisiana are in Riverton and Woolen Lake Fields. These two fields are located in parts of 

Ouachita, Richland, Franklin, and Caldwell Parishes. Southwestern Energy Company began 

drilling in June of 2005, by May of 2008 there was a total of 31 producing wells, and over 

70,000 MCF per month in the majority of 2008 as seen in (Fig.4). Maximum production rates 

for Riverton Field were 2500 MCFD before the wells started depleting. Cumulative 

production from Riverton Field as of December of 2011 was 2,262 MMCF with 10,000,000 

barrels of water out of 31 wells. 

 
Figure 4: Riverton Field production rates with Southwestern Energy Company (SWN) 

production rates with well counts per month from 6/2005-2/2009 (Foss, 2009). 
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The best well in the field is the Southwestern Energy Youngblood #1 (Fig. 5) which 

has produced  268 MMCF in 3.8 years, averaging 193 MCFD, without a decline in gas rate 

(Foss, 2009). 

 

Figure 5: Reynolds coal type log. Southwestern Energy #1 Youngblood well is located in 

section 43, T14N, R4E, in Caldwell Parish, Louisiana (Modified after Foss, 2009). 
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 Woolen Lake Field is located seven miles east of Riverton Field.  In Woolen Lake 

Field, the Reynolds coal isopach map Figure 6 shows the Reynolds coal reaching a maximum 

of 32 ft thick in the CHC #1 Lelon Kenney well (SE NE, section 15, T14N, R5E) (Fig. 7).  

Coal thickness in the 21 wells drilled in the field to date ranges from 4 to 32 ft (Foss, 2009).  

 
Figure 6: Reynolds coal isopach, Woolen Lake Field. Areas of shale-isolated (shale 

bounds the coal above and below) Reynolds coal are indicated by lighter shading, 

whereas areas of no isolation are indicated by darker shading (Foss, 2009). 

 

 Cumulative production from Woolen Lake Field as of December of 2011 was 208 

MMCF and 536 MBW from 21 wells.   
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Figure 7: Woolen Lake Field type log. CHC #11 Tensas Delta Exploration well is 

located in section 14, T14N, R5E, in Richland Parish, Louisiana (Foss, 2009). 
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     PREVIOUS WORK 

The first advances in understanding the stratigraphy of the Wilcox Group (Fig. 8) were by 

Echols and Malkins (1948). They were the first to identify the Holly Springs Delta and its 

general extent throughout the Wilcox Group in the Gulf Coast. Depositional systems of the 

lower Wilcox Group of Texas were later described by Fisher and Mcgowan (1967). Their 

studies led to the division of facies into shelf, delta, barrier bar, lagoon, strandplain, and 

fluvial systems.   
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Figure 8. Stratigraphic chart for the Cenozoic of Louisiana, indicating the position of 

the Wilcox Group (Johnston et al., 2000). 
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Galloway (1968) postulated  that the lower Wilcox Group of Louisiana, Mississippi, 

and Alabama consists of deposits of four major depositional systems; the Holly Springs Delta 

System which is volumetrically the largest system, the Pendleton Bay-Lagoon System which 

is located in eastern Texas, a restricted shelf system which lies to the east of the Holly 

Springs delta system, and an unnamed fluvial system which crops out along the flanks of the 

northward trending Mississippi trough. Galloway (1968) also determined, through detailed 

facies maps, that “two principal types of delta lobes differentiated by their areal geometry, 

internal facies relationships, and distributary channel development can be recognized in the 

Holly Springs Delta System.” Using electric logs, Galloway (1968) constructed detailed 

depositional cross sections as seen in Figure 9 to depict the provenance of prodelta muds, 

bar-finger sands, shoal water distributary mouth bars, delta front sands, interdistributary 

muds, and deltaic plain distributary channel sands. In addition, Galloway (1968) made the 

association between depositional environment and hydrocarbon production within the lower 

Wilcox Group.  
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Figure 9: Modeled log cross-sections depicting facies trends within the deltaic 

environment (Galloway, 1968). 
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 Coates (1979) as part of his master’s thesis at Louisiana State University mapped and 

identified coals within the lower Wilcox Group of Louisiana. His greatest contribution to this 

study was his implementation of subdivisions in the lower Wilcox Group that divided the 

lower Wilcox into four regional lithologic units, informally known as intervals 1, 2, 3, and 4 

(Fig. 10). These same divisions are used in this study but are identified utilizing different 

nomenclature as interval the top of the Midway Shale to Horizon 1 (Interval TopMS-H1), 

Horizon 1 to Horizon 2 (Interval H1-H2), Horizon 2 to Horizon 3 (Interval H2-H3), Horizon 

3 to the Bottom of the Big Shale (Interval H3-BBS) respectively. 
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Figure 10. Wilcox Group type log which depicts the intervals of the Wilcox Group and 

the related horizons (Modified after Han, 2010). 
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  Rogers (1983) thesis also documented lignite development and depositional 

environments of the lower Wilcox. Rogers (1983) analyzed sand body geometry, 

petrophysical properties of lignites, and developed electric log resistivity cutoff values to 

help define coals when only SP and resistivity log curves are available. Tye (1991) focused 

on regional geology, eustatic sealevel, and lithostratigraphic units.    

 Since the late 1990’s coalbed methane has gained much more attention and the 

University of Louisiana at Lafayette has been very active in mapping and explaining the 

Wilcox Group. The earliest of these studies was completed by Kinsland et al. (2003); gravity 

and magnetic surveys were analyzed to connect basement structure with depositional trends 

throughout the Wilcox Group. This prompted many subsequent studies to be done in 

north/central Louisiana on the Wilcox Group. Initial studies utilizing a subset of the available 

wells in each study area were completed by Kull (2005), Comegys (2006), Guidry (2006), 

Dew (2007), and Ball (2007) at a regional scale to gather reconnaissance level information 

on coal concentrations and structural/stratigraphic settings (Fig. 11).   
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Figure 11. Previous Regional Coalbed Methane Studies. 

 

Later more detailed studies, by Sheahan (2008), Copeland (2009), Han (2010), and 

Kruse (2011), were conducted within the boundaries of the previous regional studies and are 

considered sub-regional. These sub-regional studies dealt with smaller mapping areas within 

which all wells that penetrate the studied horizons were utilized thus providing denser well 

control, and individual coals were mapped, whereas in the reconnaissance studies only the 

cumulative thickness of coals in the individual intervals were mapped.  
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GOALS AND OBJECTIVES 

     Coalbed Methane Research Group Goals 

There are four main reasons for conducting this research. The first objective is to improve 

knowledge regarding the location and distribution of lower Wilcox Group coals throughout 

northern Louisiana. The second is to understand regional structural settings in northern 

Louisiana and their roles in lower Wilcox deposition and structure. The third is, through 

mapping the subsurface, to better understand the depositional systems that controlled 

sedimentation and produced the dynamic depositional environment of the lower Wilcox 

Group. The fourth is to support the efforts of the coalbed methane group at the University of 

Louisiana at Lafayette to compile a database of well information, digitized well logs, 3-D 

seismic, gravity data, magnetic data, structural maps, and stratigraphic maps that can be 

referenced or used by both academia and industry. 

     Study Area    

The study area comprises parts of Grant, Rapides, Avoyelles, Concordia, Evangeline, Point 

Coupee, West Feliciana, Catahoula, and LaSalle Parishes (Fig. 12). The study area 

encompasses 4,214 square miles which is equivalent to 2,700,000 acres. From the most 

northern point of the study area to the southermost point is approximately 66 miles. From the 

most western point to the most eastern point is approximately 75 miles. Its northern most 

latitude is 31.795982° N and its most southern latitude is 30.852032° S. Its most western 

longitude is -92.620465° W and its eastern most longitude is -91.3738° E.   

The study utilizes approximately 130 wells. The majority of wells drilled in this part 

of Louisiana targeted upper Wilcox Group oil sands. Many of these wells are very shallow 

and only penetrate the upper portions of the lower Wilcox Group. Thousands of wells were 
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drilled within the study area, but only wells meeting specific criteria could be used for this 

study. Wells were targeted that, at minimum, reached the anticipated depth of the Reynolds 

Coal Horizon. Wells that penetrate the entire lower Wilcox were ideal for this study.  

Prospective wells that reach the required depths must also have an accompanying well log. 

Some potential well log suites did not have the correct logs reported or the appropriate curves 

visible. Finding well logs that fit all of the requirements of this study was difficult and left 

only a small percentage of usable well logs available from the total wells that have been 

drilled in this region of Louisiana.      
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Figure 12: Boundaries of current sub-regional study. 

 
The study area was chosen for two reasons. First, the current study area had 

previously been investigated in a bigger project on a regional scale by Comegys (2006) and 

Ball (2007). These studies were for reconnaissance level information on coal concentration 

and used a general resistivity cutoff for defining coals. This investigation utilizies a greater 

variety of logs which more precisely define which instances of high resistivity are in fact 

indicative of coals.  
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   Secondly, this current study area depicted in Figure 13 borders previous sub-

regional studies completed by Sheahan (2010) and Han (2010). The completion of this 

current investigation will produce a seamless transition to previous sub-regional studies. This 

investigation will charcterize lower Wilcox Group coals in the southern limits of expected 

coal deposition.   

   

 
Figure 13: Previous and current sub-regional  CBM projects (Modified after Kruse, 

2011). 
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. 

 

 

     Nature of the Study 

 

The purpose of this study is to produce detailed structure maps at stratigraphic boundaries 

within the lower Wilcox Group (Fig. 14). Structure maps were constructed on the top of the 

Midway Shale, Horizon 1, Horizon 2, Horizon 3, Bottom of the Big Shale, and the Carrizo 

Sand.  
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Figure 14. Wilcox Group type log and stratigraphic chart with intervals defined 

by Coates (1979) (Modified after Coates, 1979). 

   

Additionally, detailed isochore maps were generated on intervals within the lower 

Wilcox Group: Interval TopMS-H1, Interval H1-H2, Interval H2-H3, Interval H3-BBS. The 

Reynolds and Russell coals are mapped individually for both areal extent and thickness. 
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 This study utilized well logs that were obtained from the Strategic Online Natural 

Resources Information system (SONRIS) of the Lousiana Department of Natural Resources 

(LDNR) and/or already in the database of the  coalbed methane project at the University of 

Louisiana at Lafayette. Logs were digitized in Neuralog, imported into Petra and correlated 

on stratigraphic boundaries.  
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GEOLOGICAL SETTING 

     Regional Geology 

The Wilcox Group is a large clastic wedge that is Paleocene to early Eocene in age. A large 

flux of terrigenous sediment was fed into the ancestral Mississippi and Red Rivers during the 

time of the Laramide Orogeny (Rainwater, 1968). These sediments were derived from the 

Western Cordilleran Mountains, and deposited in east Texas as the Rockdale Delta System, 

with reactivation of the Sabine uplift, sediments were diverted eastward into north/central 

Louisiana forming the Holly Springs Deltaic System (Galloway, 1968). One of the most 

influential features on the area is the Mississippi Trough. The Mississippi Trough acted as a 

funnel to feed clastic rich sediments from the continental interior to the Gulf Coast Basin 

(Fig. 15). 

 

Figure 15: Texas and Louisiana depositional systems (Galloway, 1968). 
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 There is an abundance of structural features in the Gulf Coast Basin that affect the 

regional geology of northern Louisiana. The most influential on sedimentation in northern 

Louisiana have been the Sabine Uplift, Monroe Uplift, the LaSalle Arch, Angelina Caldwell 

Flexure, Mississippi Salt Basin, and the Mississippi Trough (Fig. 16). The two structural 

features that have the most significant influence on the study area are the LaSalle Arch and 

the Angelina Caldwell flexure. 

 

Figure 16: Regional structures along the Gulf Coast with study area shown (Modified 

after McCulloh and Heinrich, 2002; Mississippi trough data from Galloway, 1968). 

 

Current Study 
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 The Angelina Caldwell Flexure is located just north of the study area with a small 

portion located in the study area in the north-eastern quadrant of Grant parish. It extends 

from Angelina County, Texas through west Louisiana through portions of Grant, Winn, 

LaSalle, and Caldwell Parishes. The Angelina Caldwell flexure is a monocline that was most 

prominent as a feature influencing deposition during the Late Cretaceous and Paleogene 

(Ambrose et al., 2009). North of the flexure there is very gentle south dip.  South of the 

flexure dip is more toward the south and increases by a factor of almost 10 compared with 

dip north of the flexure (Echols, 2001). 

  The LaSalle Arch is located in the north central portion of the study area.  Its extent 

is limited to parts of Grant, LaSalle, Catahoula, and Avoyelles Parishes. The arch can be seen 

throughout all Wilcox Group horizons mapped.  It’s effect on structure is a locally higher 

region with gentler dip than adjacent areas. The LaSalle Arch axis is oriented northwest to 

southeast with a significantly exagerated nose to the southeast. Strata on top of the LaSalle 

Arch are much thinner than strata on the flanks that have a much thicker vertical section.  

Lawless and Hart (1990) postulated that the LaSalle Arch basement complex consists of 

Paleozoic continental crust which caused overlying strata to become uplifted, forming an 

anticline. The western limb formed by differential subsidence during the early Paleogene and 

the eastern limb formed due to regional tilting sometime during deposition of the Sparta 

Formation of the Claiborne Group during the middle Eocene (Lawless and Hart, 1990).   

 Eustatic sea level rise during the Late Paleocene and Early Eocene played a big role 

in the regional geology of coastal areas. The lower Wilcox is dominated by transgressive 

sequences, high stand systems tracts, and low stand systems tracts. The resulting 

parasequences of the lower Wilcox Group are progradational, aggradational, and 
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retrogradational. This is illustrated in Figure 17 in which Tye et al. (1991) compared lower 

Wilcox sequence stratigraphy to a eustatic sea level curve adopted from Haq et al. (1987).   

 
Figure 17. Correlation of global eustatic sea level from Haq et al., (1987) to the Lower 

Wilcox Group intervals derived from Coates (1979) and the adopted zones of Tye et al. 

(1991) (Modified after Tye et al., 1991). 

  

 

     Coal Development 

 Coal is derived from peat that has been changed chemically and physically. A specific set of 

environmental conditions are required to develop the vegetation necessary to form peat and a 

delicate equilibrium must exist to accumulate adequate quantities to eventually develop 

coalbeds (Flores, 1993). The process of coalification occurs when peat undergoes multiple 

changes as a result of bacterial decay, compaction, heat, and time (Kentucky Geological 

Survey, 2012).  Peat deposits are quite diverse and include everything from pristine plant 

parts (bark, roots spores, etc.) to decayed plants, decay products, and even charcoal if the 
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peat caught fire during accumulation (Kentucky Geological Survey, 2012). Peat can form 

into coal when peat has undergone rigorous compaction in burial, water loss, increased 

pressure, and increased temperature (Kentucky Geological Survey, 2012). As peat undergoes 

these changes it transforms through peat, lignite, sub-bituminous coal, bituminous coal, 

anthracite coal, to graphite (Kentucky Geological Survey, 2012). Coal rank Figure 18 is 

based on burial depth, temperature experienced, and time under these conditions. This is 

similar to conventional petroleum source rock maturation; coal is the source rock and 

reservoir rock for the majority of coalbed methane production (Moore, 2007). The rank 

affects the coals overall permeability, cleating orientation, absorption, and generally the 

producibility of hydrocarbons (Moore, 2007).       

 For detailed discussion of the depositional environments in which coals form, the 

following literature should be sought Coates (1979), Coleman et al. (1983), Farre et al. 

(1983), Fisher et al. (1967), Flores (1993), Frazier et al. (1969), and Galloway (1968). Their 

discussion was focused on peat deposition in the fluvial and deltaic environment, related to 

channel avulsion, channel abandonment or reclamation, and other conditions prone to 

accumulate peat.  Studies by Flores (1968) and Frazier (1967) should be referenced for 

information regarding fluvial depositional environments of coal. Additionally, the article by 

Horne et al. (1978) should be consulted for discussion of lower delta plain reconstruction and 

lithologic characteristics of coal bearing environments.        
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Figure 18. Coal Rank with corresponding BTU values and with the Wilcox Group 

range highlighted (Modified after Schweinfurth, 2004). 

 

      

 



    

 30 

METHODS AND PROCEDURES 

 

     Well Log Analysis - Sand 

Evaluation of well logs was the primary technique used in this project. In the state of 

Louisiana, it is required by the Louisiana Deparment of Natural Resources (LDNR) Office of 

Conservation, that all one inch scale electric logs be made public. Operators of wells 

shallower than fifteen thousand feet are allowed a period of one year before being released to 

the public, plus one additional year if evidence is submitted that the well is part of a 

leasehold interest; operators of wells deeper than fifteen thousand feet are allowed two years 

before the log has to be released. Unfortunately the spontaneous potential (SP) log is not 

ideal for determining coals. Deep resistivity logs are also not conclusive for determining 

coals as calcareous shale yields a combination of SP and deep resistivity signatures very 

similar to a coal. With this study being sub-regional and therefore more detailed in nature, 

special care was taken in acquiring well logs with additional logging suites. This is more time 

consuming as you have more files to sift through and more log curves to evaluate. However, 

being able to accurately discern coals from calcareous shales (tight streaks)  makes the 

resulting maps more accurate and the project that much more valuable. The most diagnostic 

logging tools for recognizing coals but which are not required to be made public are Gamma 

Ray (GR) logs, Density logs, Neutron logs, and Sonic logs. The GR tool measures bulk 

gamma rays emitted from the radioactive minerals in the immediate vicinity of the well bore; 

coals usually have a low GR response because the concentration of clay minerals are low 

(Halliburton, 2007). The bulk-density log is a high-energy gamma ray tool, that is an 

excellent coal indicator, the density and neutron log are typically run in combination to most 

accurately identify coals (Halliburton, 2007).  The neutron porosity tool responds to the 
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hydrogen index of the matrix rock; coal has one of the highest hydrogen index values of 

common minerals encountered in sedimentary depositis (Halliburton, 2007). Thus, in coal, 

the neutron porosity tool is a good indicator of coals. Sonic logs can aid in recognition of 

coals by their long transit times, which typically is longer than most any other formation in 

the well (Halliburton, 2007). With the aid of these additional logs most lithologies in this 

area can be characterized as either sandstone, shale, limestone, or coal. One problem that 

arises when dealing with a large number of well logs is the varying ranges in measured 

voltage used for measuring SP. Petra software can account for this problem by normalization, 

which calibrates the curves of various logs to a common scale. The base line shift method 

was used in this project to correct for this problem. The base line shift method adjusts the log 

curves in scale to match other log curves based on the computed average of all curves being 

analyzed. This method revises the scales of the logs while conserving the original geometry 

of the curves. Petra was used to compute log statistics as shown in Figure 19. Throughout 

this study the 5
th 

percentile, 95
th

 percentile, and 50
th

 mean percentile SP value for all wells 

were computed in the histogram module in Petra. A SP cutoff value was derived from these 

computations and applied to all logs in the project. This cutoff is used to compute net 

footages for the gross interval isochore maps, net sand maps, and net sand to gross interval 

ratio maps. 
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Figure 19. Log Statistics for computing sand cutoffs and footages using the 5
th

, 95
th

, and 

50
th 

 mean percentile SP value. 

     Well Log Analysis - Coal 

Previous regional studies conducted by Kull (2005), Comegys (2006), Guidry (2006), Dew 

(2007), and Ball (2007) employed a “Quick Look” technique which attempted to identify 

coals based solely on resistivity cutoffs.  Kull (2005) used a cuttoff value of 2.5 ohm-meters 

to delineate coals, higher than 2.5 ohm-meters was considered a coal, and lower than 2.5 

ohm-meters was not considered a coal. Subsequent regional studies tried to develop this 

technique by assigning small changes in resistivity cutoff values to specific geographic areas 

based on log response. These techniques can give erroneous results when searching for coals 

because of the vast size of data sets, large numbers of well logs to be normalized under the 

same log scale, resistivity changes with deeper logs, and digitizing errors as well as the 

ability to distinguish coals from calcareous shales.   
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In this study, coals were first picked with the assistance of additional log curves other 

than spontaneous potential and resistivity. Gamma Ray was the third most prevalent log 

available amongst the wells in the study area. Just 19 well logs within this study contained 

one or more of the following curves: GR, Neutron Porosity, Density Porosity and/or Sonic. 

Depicted in Figure 20 are wells with logs in addition to the usual SP and resistivity curves 

required by the state. In this study, each individual log curve was evaluated alone and in 

combination rather than relying on a general coal resistivity cutoff. Advanced logging suites 

were first sought for identifing coals. These advanced logs were then compared with basic 

logging tools to better recognize coals with just SP and deep resistivity logs.   
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Figure 20. Wells with advanced logging suites in the study area. 

 Generally, newer vintage 5-in logs contain all of the above mentioned logging tool 

data and were the first logs interpreted for coal occurrence. Once the coals were picked using 

5 inch logs, then logs containing just Gamma Ray logs (in addition to the deep resistivity) 

were utilized. Well logs with just SP and deep resistivity logs were used to pick coals where 

a generally high SP response was combined with a high deep resistivity response. Resistivity 

values for determining coals vary quite a bit throughout the study area due to the large size 

and large variation in depth of burial, but most coals picked had resistivity values over 3 

Ohms-meters. The Justiss Oil Company #1 5 in log seen in Figure 21 shows the presence of 

coal seams with a combination of SP, GR, RWA, deep resistivity, and Sonic logs.        
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Figure 21. Example of numerous coal seams that are identified in the Justiss Mary 

Pipes et al. #1 with the use of a 5 in log. 

 General cutoffs for identifying coals through well logs are Bulk Density < 2gm/cm
3
, 

Gamma Ray < 60 API, Neutron Porosity > 50%, Sonic Transit Time > 80μs/ft, Shear Transit 

Time > 180μs/ft, and Resistivity > 0.5 ohm-meters (Rogers et al., 2007). Coals can occur 

outside of these parameters, as these are general cutoff values; the typical well log response 

can be seen in Figure 22. 
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Figure 22. Typical well log responses to coal (Wood et al., 2003). 

 Coals were identified in Petra using the “Pay Intervals” function and marked as “pay” 

within each mapped interval. This function made it easy to pick coals and map them because 

the software allows you to assign a top and base to the coal of choice. You can then simply 

select top of coal for all of your picks for the selected coal and quickly produce a structure 

map on that surface. Petra also allows you the ability to color code the coals in each interval 

for easier identification. All coal picks in Interval TopMS-H1 are colored black. All coal 

picks in Interval H1-H2 are colored blue. All coal picks in Interval H2-H3 are colored red.  

All coal picks in Interval H3-BBS are colored green.  Once all coals had been selected, the 

Petra software categorized them in the database as “Zones”. These “Zones” were then used to 

produce isochore maps of coal thickness for each interval. A type log of the lower Wilcox 

showing the color scheme for coals within the lower Wilcox can be seen in Figure 23. Coals 

were then summed from all intervals picked to create a coal thickness map for the entire 

lower Wilcox.      
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Figure 23. Type log showing color coded coal intervals. 

     Data Acquisition 

The study area was chosen as a continuation of sub-regional studies in the area that had 

previously been mapped on a regional scale for reconnaissance level information. These sub-

regional studies utilized all available well logs and the areas were evaluated in much more 
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detail including mapping of individual coals. The northern boundaries of the study area were 

chosen to abut against the previous sub-regional studies of Han (2010) and Sheahan (2008) 

so there could be a seamless transition in correlations. The eastern boundary of the study area 

is the Louisiana-Mississippi border; no wells were to be utilized from Mississippi. The 

western boundary abuts against the southeast corner of the Han (2010) area and forms a 

linear border south of this interface. The southern boundary was selected so as to include 

several deeper wells that penetrate the entire section of the lower Wilcox.    

 The initial step for seeking potential wells in the study area was to reference the past 

regional studies conducted by the Univeristy of Louisiana at Lafayette coalbed methane 

group. A number of regional studies have been done within and around the outlined study 

area. The database, which is managed by the coalbed methane group was carefully 

investigated for wells that are inside the study area. 55 wells were available that had been 

previously digitized and utilized in regional studies. Once this phase was complete, the 

Strategic Online Natural Resource Information System (SONRIS) was utilized.  SONRIS has 

a very useful GIS application that lets you view wells within Louisiana. This application 

allows you to view these wells in multiple map forms and also gives you the ability to 

activate multiple layers (Fig. 24). All wells in the study area were evaluated to select those 

with the required curves and which reach the depth of the Reynolds coal, the deepest coal of 

likely commercial interest. 
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Figure 24. Detailed map generated in the GIS application of SONRIS over study area 

(SONRIS, 2014). 

 Once all of the wells in the study were found that meet the above requirements, the 

raster logs from the Louisiana Department of Natural Resources (LDNR) were downloaded.  

The raster logs were then imported into Neuralog software. Neuralog was used to digitize, 

straighten, and adjust raster images in a manner to best show log characteristics for additional 

interpretation software. These raster images were then exported from Neuralog and imported 

into the Petra project. The log header and other relevant information relating to each well log 

were entered into the Petra project. This made accessing information  about each well during 

the interpretation portion of this study very easy because all of the location and log data were 
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in the project. Many of the older wells did not include Kelly Bushing (KB) or elevation 

information. Regional topographic maps and Goggle Earth were utilized to determine proper 

elevation for designated wells. Kelly Bushing values were estimated using nearby wells or 

wells with similar depths of penetration (which relies on an assumption of similar drilling 

rigs being used to drill to similar depths). Once all well data were incorporated in the project 

the wells could then be evaluated. The previously digitized regional wells were first 

correlated for proper correlation points. New wells were incorporated with known correlative 

horizons. The logs in Petra were used to produce cross-sections, correlate formation tops and 

coals, produce various isochore maps, evaluate log statistics, and determine lithology cutoffs.  
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MAPPING RESULTS AND DISCUSSION 

     Order Of Discussion 

The structure of the Wilcox Group is discussed first. In this discussion, all horizons mapped 

are presented from oldest to youngest. The horizons include the top of the Midway Shale, 

Horizon 1, Horizon 2, Horizon 3, the Bottom of the Big Shale, and the top of the Carrizo 

Sand. Following the discussion of the Wilcox structure, the major stratigraphic intervals of 

the lower and upper Wilcox are discussed. As with the structure, the intervals are discussed 

in order from oldest to youngest. These intervals include: Interval TopMS-H1, Interval H1-

H2, Interval H2-H3, Interval H3- BBS, and Interval BBS-TopW. The analysis of each 

interval includes a gross interval isochore map, a net sand thickness map, a net sand to gross 

interval ratio map, and a net coal isochore map. The Reynolds and Russell coal are discussed 

individually, with a structure map and  net coal isochore map for each. Additionally, the 

entire lower Wilcox group as a whole is disucssed. The discussion of this interval includes a 

gross interval thickness map, a net sand map, a net sand to gross interval ratio map, and a net 

coal isochore map.  

     Top of the Midway Shale Structure 

The top of the Midway Shale is the lowermost boundary of the lower Wilcox Group (Fig. 

25).  It is an excellent correlative marker that lies above the Cretaceous. The top of the 

Midway Shale is characterized by an extensive shale sequence with interspersed sandstone 

occurrences. The mapping surface for the top of the Midway Shale in this study is 

consistently an abrupt change in SP response above a thick shale interval at the base of the 

lower Wilcox Group. The shallowest penetration of the top of the Midway Shale is by the 

Placid Oil #2 in section 3-8N-2E at a depth of -4018’ (Fig. 32). The top of the Midway Shale 
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exhibits 7,945’ of structural relief from the Placid Oil #2  to the southernmost well in the 

study the Moncrief Ducote #1. South to southeast dip is clearly defined over the entire 

portion of north-central Louisiana at the top of the Midway Shale horizon. In the northern 

half of the study there is a considerable amount of east dip (Fig. 31) compared with the 

southern portion where it starts to trend more toward the south. Many of the wells in the 

study area do not reach the top of the Midway Shale. With the decrease in well control,  

important structural features are not seen and/or their characteristics less well defined. The 

relief of the LaSalle Arch is almost unrecognizable due to the low number of penetrations at 

this horizon and their distribution such that there is almost no control to the west of the 

LaSalle Arch in the study. Approximately 70 wells reached the top of the Midway Shale in 

this study.   
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Figure 25. Top of the Midway Shale Structure Map. 
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     Horizon 1 Structure 

The mapped horizon next above the top of the Midway Shale is Horizon 1 (Fig. 26). The 

shallowest penetration of Horizon 1 in this study is by the Placid Oil #2 in section 3-8N-2E at 

a depth of -3,396’. Horizon 1 exhibits 7,844’ of structural relief from the Placid #2 to the 

southernmost well in the study.  Horizon 1 is consistently found in 88 wells throughout the 

study area. Horizon 1 is defined as a Type 2 sequence boundary that occurred 60Ma 

(Kinsland, 2013). The increase in well penetrations compared with the top of the Midway 

Shale horizon is most apparent in the central and east portions of the study (Fig. 33). Slight 

east and west dip around the arch accentuates the structural feature.  General dip is similar to 

the top of the Midway Shale, south /southeast.   
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Figure 26. Horizon 1 structure map. 
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     Horizon 2 Structure 

The next mapped horizon above Horizon 1 is Horizon 2 (Fig. 27). The shallowest penetration 

of Horizon 2 in this study is by the Placid Oil #2 in at a depth of -3,109’. Horizon 2 exhibits 

7,645’ of structural relief from the Placid #2 to the southernmost point of the study.  

Approximately 106 wells penetrate Horizon 2 in this study. Horizon 2 is interpreted as a 

Type 2 sequence boundary with an overlying shelf margin within which the Russell coal 

accumulated (Kinsland, 2013). The Horizon 2 sequence boundary occurred 58.5 Ma 

(Kinsland, 2013). More well control is apparent at this horizon compared with deeper 

horizons.  The structural features in Horizon 1 generally carry over to Horizon 2. These two 

horizons are virtually identical and exhibit no real change in structure. Correlations are not 

always consistent at this horizon; some wells have notable shale breaks for the surface of 

Horizon 2.  However, some wells, have large box car sand sequences that completely cover 

the anticipated correlative surface. These wells which are difficult to correlate have likely 

penetrated a channel which has cut through the mapping horizon. When this situation occurs, 

the anticipated surface is picked that best fits the geology, log response, and nearby wells.      
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Figure 27. Horizon 2 structure map. 
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     Horizon 3 Structure 

The next mapped horizon above Horizon 2 is Horizon 3 (Fig. 28). The shallowest penetration 

of Horizon 3 in this study is by the Placid Oil #2 at a depth of -2,678’. Horizon 3 exhibits 

7,770’ of structural relief from the northernmost well to the southernmost well in the study.  

Horizon 3 is penetrated in 126 wells throughout this study.  The increase in well density 

significantly alters the mapped structure compared with deeper mapped horizons with less 

well density. The LaSalle Arch really stands out in this horizon. The arch has gone from a 

flatter, less exaggerated feature at older horizons to more of an elongated nose at shallower 

horizons where well control is better. This nose is greatly exaggerated with east and west dip 

on the flanks of the arch (Fig. 34).  The boundary at Horizon 3 is difficult to define with well 

logs as this horizon is located within a dynamic time period where sequence boundaries 

shifted between lowstand, transgressive, and highstand systems tracts (Tye et al., 1991).  
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Figure 28. Horizon 3 structure map. 
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     Bottom of the Big Shale Structure 

 

The horizon above Horizon 3 is the Bottom of the Big Shale (Fig. 29).  The Bottom of the 

Big Shale is the upper boundary of Interval H3-BBS and the lower boundary of Interval 

BBS-TopW. The Bottom of the Big Shale is the upper boundary of the lower Wilcox Group 

and the lower boundary of the upper Wilcox Group. Similar to other mapped horizons the 

shallowest penetration of the Big Shale is seen in the Placid Oil #2 well at a depth of -2,349’.   

The Big Shale exhibits 7,647’ of structural relief from the Placid #2 to the southernmost well 

the Moncrief Ducote #1. Approximately 130 wells penetrate the Bottom of the Big Shale in 

this study. The Big Shale is a marine transgressive shale of sub-regional extent that separates 

the upper and lower Wilcox Group (Galloway, 1968). The abrupt lithologic contact at the 

Bottom of the Big Shale corresponds to sea level fall at 56 Ma, the degree of which would 

have been adequate to expose the continental shelf to subaerial exposure (Tye et al., 1991). 

Correlations at the Bottom of the Big Shale are excellent within the confines of this study. 

The result of the improvement in precision of correlations can be seen in comparisons 

between the older horizons and the Bottom of the Big Shale where contour spacing is much 

better and contours are smoother, producing a much cleaner map.   
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Figure 29. Bottom of Big Shale structure map. 
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     Top of Wilcox (Carrizo Sand) Structure 

 

The uppermost and final horizon of this study is the Top of the Carrizo Sand (Fig. 30). The 

Top of the Carrizo Sand is the upper boundary of Interval BBS-TopW.  The Top of the 

Carrizo Sand is also the upper boundary of the Upper Wilcox Group. The shallowest 

penetration of the Carrizo Sand is by the Placid Oil #2 at a depth of -1,835’. The Carrizo sand 

exhibits 6,666’ of structural relief from the northernmost well the Placid #2 to the 

southernmost well the Moncrief Ducote #1 in North Bayou Jack Field. Approximately 130 

wells penetrate the Carrizo Sand in this study. Additionally this horizon is an excellent 

correlation point throughout all of the wells in the study. The Carrizo sand can be 

characterized by a coarsening upward sequence followed by the thick shale section of the 

Cane River Shale before encountering younger sandstone packages. This horizon can be 

easily and accurately correlated in cross-sections for over 50 miles, proving its excellent 

correlatibility (Fig. 35).   



    

 53 

 
Figure 30. Top of Carrizo Sand structure map. 
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Figure 31. North-South line A-A’ through eastern portion of study area. 
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Figure 32. Cross section A1-A1’. 
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Figure 33. Cross section B-B’ through study area. 
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Figure 34. Cross section B1-B1’. 
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Figure 35. Cross section B2-B2’. 



    

 59 

 

     Interval TopMS-H1 

 

Interval TopMS-H1 is bound at its base by the top of the Midway Shale and at its top by 

Horizon 1. This interval represents the lowest interval of the lower Wilcox Group. Interval 

TopMS-H1 can be recognized on well logs as consisting of coarsening upwards packages 

indicative of a progradational delta system. Approximately 70 wells in the study area 

penetrate this interval. The wells that penetrate this interval were used to create interval 

isochore, net sand thickness, net sand thickness to gross interval ratio, and net coal thickness 

maps.           

 The interval isochore map shows the gross thickness of the Interval TopMS-H1 (Fig. 

36).  The Tensas Delta Land Company #1 in LaSalle Parish has only 294’ of gross interval 

thickness.  This well is located at the north boundary of the study just east of the LaSalle 

Arch. This interval greatly thickens toward the south and east, the John T. Palmer #1 has 

751’ of gross interval thickness toward the south-central portion of the study. Interval 

thickness greatly increases to the southwest where many wells have in excess of 500’ of 

gross section. The western side of the study is poorly defined at this interval by the low 

number of well penetrations. 

The net sand map shows the amount of sand that each well contains in Interval 

TopMS-H1 (Fig. 37). The lowest net sand area is in the most northern portion of the study in 

parts of LaSalle and Catahoula Parishes. This low net sand area spans about 10 Townships 

with sand values less than 250’. South of the thin area the sand footages increase; some wells 

have net sand thicknesses in excess of 500’. The orientation of the higher net sand thickness 

pattern suggests a meandering delta system. The delta system stretches from Catahoula and 

Concordia Parishes all the way to Avoyelles Parish. The north-central portion of the delta 
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complex is roughly 10 miles wide and increases to over 25 miles in the southern limits of the 

study. The delta system is adjacent to the north and west to areas of low net sand which helps 

define the higher net sand delta system. 

The net to gross interval ratio map is similar to the net sand map (Fig. 38). The lowest 

net to gross ratio values are around 0.37 with values as high as 0.94. The thickest 

accumulations on the gross interval isochore map are present in the central and southwestern 

portions of the study area. These thicknesses conform to the net sand map with high sand 

content, likely deposited by a delta. The delta complex seen in the net sand map isn’t as 

clearly visible in the net to gross ratio map. Noticeable features of the delta are subtle. 

The net coal map for this interval shows a high concentration of coals toward the 

north portion of the study area (Fig. 39).  7N-3E, 8N-3E, and 8N-4E contain the thickest coal 

deposits.  Nine wells in parts of LaSalle and Catahoula Parishes have over 10’ of net coal in 

this interval. The IPB LLS #125 in section 12-8N-4E in LaSalle Parish has a total of 27’ of 

net coal which is the highest coal footage documented in this interval. A total of 28 wells in 

Interval TopMS-H1 have occurrences of coal out of 70 wells that penetrate the Midway 

Shale. All wells south of Township 3N have 0’ of coal. This interval should have significant 

coal development north of the study area due to the location of the shoreline and there being 

good coal deposits at the northern boundaries of the study area. 
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Figure 36. Interval Midway Shale – Horizon 1 gross interval map. 
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Figure 37. Interval Midway Shale – Horizon 1 net sand map. 
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Figure 38. Interval Midway Shale – Horizon 1 net sand to gross interval ratio map. 
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Figure 39. Interval Midway Shale – Horizon 1 net coal isochore map. 
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     Interval H1-H2 

 

Interval H1-H2 is bound at its base by Horizon 1 and at its top by Horizon 2. This interval 

represents the second deepest interval of the lower Wilcox Group. Interval H1-H2 can also 

be recognized on well logs as a coarsening upwards package with intermittent shale breaks, 

indicative of a progradational and aggradational delta system. Out of 130 wells that were 

selected for this study, 88 wells penetrate this interval.    

 Interval H1-H2 is very similar to the Interval TopMS-H1 where there is a thin interval 

toward the north (Fig. 40). However, at Interval H1-H2 the thin gross interval section is 

located further to the west, directly overlying the LaSalle Arch. Some wells like the Mary 

Pipes #1 in Trout Creek Field have as little as 246’ of gross interval in this thin area. The 

interval gradually thickens to the east to over 1000’ in the California Time & R.C. Bertolet 

#1 in section 26-6N-9E of Concordia Parish. Wells with greater than 600’ of gross interval 

are present in the southwest of the study area and majority of the eastern portion of the study 

area. They are connected by a thicker swath of wells that abut to the north and south wells 

with 400’ of gross section. 

 The net sand map is very similar to the gross interval map at Interval H1-H2 (Fig. 

41).  Many of the same features carry over, such as the thin area on top of the LaSalle Arch 

and the gradual thickening to the east. The Atlantic Logan & Mckeever #1 in Rapides Parish 

has only 91’ of sand with wells around it averaging 200’. Due east the sand thickness greatly 

increases to 768’ in the Fife Oil & Gas #1 in section 20-7N-10E of Concordia Parish. Many 

of the wells on the eastern portion of the study area are relatively thick. The Mississippi 

Embayment is likely the reason for the greater thicknesses in this part of the study area. 
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 The net to gross ratio map shows the same high value section in the eastern portion of 

the study area as did the net sand and gross interval maps (Fig. 42). The net to gross ratio 

map also depicts a high value trend of over 0.6 oriented north to south in the center of the 

study and extending 40 miles. Net to gross ratio values are as low as 0.3, with values as high 

as 0.95 present. As mentioned before, many wells didn’t reach this interval so well control 

isn’t as good as compared with shallower intervals. 

 The net coal map of Interval H1-H2 contains many more occurrences of coal than the 

deeper Interval TopMS-H1(Fig. 43). Similar to the deeper interval, the coals are most 

concentrated in the northern portion of the study area in LaSalle and Catahoula Parishes. The 

Interval H1-H2 contains the Reynolds coal. The Reynolds coal is the thickest most extensive 

regional coal found throughout northern Louisiana. The northern concentration of coals range 

from around 15’ to 28’of net coal. The J Balfour Miller et al. #1 in section 1-8N-9E of 

Concordia Parish has the highest accumulation of net coal in this interval with 28’ of coal.  

Three separate trends emerge when looking at the orientation of coal footages at this interval.  

In LaSalle Parish multiple wells have 15’ to 25’ of coal, the net footages decrease to the 

south, and increase to 16’ of net coal in 4N-1E. Similarly this same situation occurs south of 

thick net coal wells in Catahoula Parish and south of thick net coal wells in Concordia Parish. 

There seems to be no development of coal south of Township 2N. 
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Figure 40. Interval Horizon 1 – Horizon 2 gross interval map. 
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Figure 41. Interval Horizon 1 – Horizon 2 net sand map. 
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Figure 42. Interval Horizon 1 – Horizon 2 net sand to gross interval map. 
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Figure 43. Interval Horizon 1 – Horizon 2 net coal isochore map. 
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     Interval H2-H3 

  

Interval H2-H3 is bound at its base by Horizon 2 and at its top by Horizon 3. This interval 

represents the second shallowest interval of the lower Wilcox Group. Interval H2-H3 can be 

recognized on well logs as a coarsening upwards set of parasequences and an upward-fining 

set of parasequences. This part of the lower Wilcox section contains lowstand, highstand, and 

transgressive systems tracts (Tye et al., 1991). This Interval is dated as between 58.5 Ma and 

56.5 Ma. Out of 130 well logs selected for this study, 106 wells penetrate the Interval H2-H3. 

 The gross interval map shows a generalized thick area in the center of the study area 

with a maximum gross interval thickness of 746’ from the Hassie Hunt Trust #2 in section 

22-5N-4E of LaSalle Parish (Fig. 44). Wells to the north and south of the thick section are 

thin with values as low as 205’ of gross interval thickness. On the eastern flanks of the study 

area many of the wells are thick with many wells having in excess of 400’ of gross interval.   

 The net sand map is similar to the gross interval map (Fig. 45). A localized thick area 

is present in the north/central portion of the study area with wells having in excess of 450’ of 

net sand localized in the southern portion of LaSalle Parish.  To the east most wells have over 

250’ of net sand that increases to 599’ of sand in the Fife Oil & Gas #1 well in Concordia 

Parish. To the south and west of these thick net sand accumulations sand values decrease 

substantially. Many wells spanning 60 miles have less than 200’ of net sand in Rapides and 

Avoyelles Parishes 

 Like previously mapped intervals, the same features in the net sand map carry over to 

the net to gross ratio map (Fig. 46). There is a high value area in the north/central region of 

the study area and the entire eastern portion of the study area has high net to gross ratio 

values. Many wells have net to gross ratio values as high as 0.9 while lower values are 
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around 0.2. The entire study area with the exception of the southwest has high net to gross 

ratio values. The high net to gross values are likely due to proximal, delta-front deposits, 

consisting of a wave dominated shoreface (Bhattacharya et al., 1991). 

 The net coal map of Interval H2-H3 shows thickest values in the north western 

portion of the study area (Fig. 47). The Robert Jenkins #1 in section 29-5N-2E of Rapides 

Parish contains 59’of net coal which is the highest coal footage documented in one interval 

within the lower Wilcox within this study area. Many wells surrounding the Robert Jenkins 

#1 have in excess of 20’ of net coal. The Russell coal is a laterally extensive coal within this 

interval and has been mapped in detail throughout northern Louisiana in other studies. Coals 

within this interval tend to be thinner but more prevalent. This is due to dynamic changes in 

active and inactive depositional environments. There are also a few significant coal 

occurrences on the eastern limits of the study area. The R.B. Sharp #1 in Concordia Parish 

has 19’ of coal with several wells around it averaging 10’ of coal per well. Between these 

two consistent coal accumulations are some sporadic coal footages ranging from 0’ to 17’.  

South of Township 2N there are no coal occurrences. This area south of Township 2N was 

likely basinward of the fluvial to paralic environments within which coals of northern 

Louisiana developed. 
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Figure 44. Interval Horizon 2 – Horizon 3 gross interval map. 



    

 74 

 
Figure 45. Interval Horizon 2 – Horizon 3 net sand map. 
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Figure 46. Interval Horizon 2 – Horizon 3 net sand to gross interval ratio map. 
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Figure 47. Interval Horizon 2 – Horizon 3 net coal isochore map. 
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     Interval H3-BBS 

 

Interval H3-BBS is bound at its base by Horizon 3 and at its top by the Bottom of the Big 

Shale. This interval represents the highest interval of the lower Wilcox Group. Unlike the 

previous two intervals, Interval H3-BBS can be recognized on well logs as continuously 

coarse packages, indicative of an aggradational system. Out of 130 well logs that were 

assembled for this study area, 126 wells penetrate this interval. 

 The gross interval map shows a thin area to the northeast with wells gradually 

increasing in thickness to the west. Some wells have gross thickness values as low as 248’ in 

the T. J. Guido & Serio #B-1 in section 46-4N-8E of Concordia Parish. There are two thick 

gross interval sections oriented northwest to southeast. The gross interval accumulation to the 

north is located in LaSalle Parish, the southern high gross thickness accumulation is located 

in Avoyelles Parish. These thick areas have over 800’ of gross section in some wells and 

span multiple Townships. Separating these two thick accumulations is a much thinner 

interval of wells that are perpendicular to the northwest to southeast trending thick section.  

These thinner wells average 400’ of section and are drastically different in log character.  The 

well log response of these wells within the thin section is an elevated SP response and, 

because of the amount of shale, appears to be of marine origin. Interval H3-BBS is normally 

composed of interstratified sandstone and shale occurrences, but in this area the strata 

consists of an anomalously thick shale interval. Analogous shales in other areas have mostly 

been interpreted as submarine canyon fill (Hoyt, 1959).  (McCulloh et al., 1986) found 

evidence of a large shale-filled channel within the lower Wilcox Group in portions of St. 

Landry and Avoyelles parishes. Figure 48 depicts the position of the St. Landry Canyon 

identified by (McCulloh et al., 1986) and its presence within the current study. 
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Figure 48. Shale filled-channel that is present within the lower Wilcox Group (Modified 

after McCulloh et al., 1986). 

 

The gross interval and net sand maps of Interval H3-BBS show the existence of what 

is believed to be a branch of the St. Landry Canyon. Figure 50 shows the Humble-Tensas 

Delta D-2 (#129885) well in section 22-5N-4E of LaSalle Parish to have a reduction in sandy 

facies between the upper Wilcox and Horizon 3. This well has 50% less sand and gross 

interval thickness than surrounding wells. The Humble D-2 strata have likely been eroded by 

the St. Landry paleo-channel, replacing sand with interstratified shale (Fig. 49). The Humble 

D-2 has most likely encountered a branch of the paleo-channel that originates in Catahoula 

and Concordia Parish. The two branches of the paleo-channel meet in northern Avoyelles 

Parish where the channel continues for approximately 25 miles before bifurcating once more 

in southern Avoyelles Parish toward the south into St. Landry Parish. 
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Figure 49. Cross section showing erosion in well #129885 at Horizon 3 to the Carrizo 

Sand. 

 

 

Recent discoveries of productive Paleocene to Eocene aged Wilcox Group sands in 

the deepwater Gulf of Mexico has left scientists questioning how these sands were deposited 

so far offshore. At present there are multiple theories’s regarding this topic. Rosenfield et al. 

(2003) found through paleogeographic reconstructions that the Florida Straits near Cuba 

were closed, effectively cutting off the Gulf of Mexico. This isolation of the Gulf of Mexico 

led to the drawdown in water level which caused deep incisions throughout the northern gulf 

coast. The most obvious features associated with drawdown of the Gulf of Mexico are the 

Yoakum, Smothers, Hardin and Lavaca canyons of southern Texas and the St. Landry 

canyon in central Louisiana (Sweet et al., 2011). These canyons resemble features seen in 

other basins like the Black Sea and the Mediterranean, which underwent desiccation 
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(Rosenfield et a., 2003).  Berman et al., (2007) utilized results of recently drilled wells in the 

deepwater Gulf of Mexico to infer that drawdown occurred 55Ma, which brought sand-rich 

fan deltas into Alaminos Canyon and surrounding areas in the Gulf of Mexico, and 

accounted for deposition of the observed Wilcox deepwater sandstones. 

Alternatively, a simpler theory is that thick Wilcox sands in the deep waters of the 

Gulf of Mexico were deposited by a large river system. Galloway (2008) argues that while 

the Florida Straits could have been closed during this time, the Suwanne Straits of northern 

Florida were open, preventing isolation of the Gulf of Mexico. Sweet et al. (2011) deduce 

that there is nothing unusual about the scale of canyons reported to have sourced the 

deepwater Wilcox Group sands, nor the distance over which these sands were transported.  

Sweet et al. (2011) postulate that the Wilcox aged basin-floor fans are the distal end of a 

continental-scale sediment dispersal system with slope to basin-floor mechanisms on the 

magnitude of a large continental-scale fluvial system.   

The formation of the south Louisiana channel within a time period represented by an 

interval no thicker than Interval H3-BBS suggests that cutting was relatively rapid, as with 

canyons where mass movement systems are thought to have predominated (McCulloh et al., 

1986). A more detailed explanation must await the deciphering of chronostratigraphic and 

lithofacies relations between the channel shale and the Big Shale marker, the tracing of the 

channel farther downdip to establish the nature of its terminus, and the development of 

sufficient syntheses of tectonic, paleohydrographic, eustatic, climatic, and other variations 

that took place during Wilcox deposition (McCulloh et al., 1986). The Yoakum has 

associated productive cut-and-fill, compaction, and stratigraphic hydrocarbon traps along its 

entire length (Chuber and Begeman, 1982), and this has great implications for the St. Landry 
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Canyon, as the shale-filled channel can act both as a source rock for oil or gas and also as a 

seal. 

The net sand map best highlights the paleo-channels’s orientation and thickness (Fig. 

51).  Based on the net sand map, the width of the channel is between 6 miles and 8 miles.  

The thick net sand wells are oriented in a northwest to southeast manner. Some of these wells 

have sand values greater than 500’ are located in Township and Range 5N-3E, 6N-3E, 6N-

4E, 7N-3E, 4N-5E, 3N-5E, and 3N-4E. Adjacent to these two accumulations of high net 

sand, many wells do not have a great deal of sand. The average net sand thickness for 

Interval H3-BBS is 239’; this showcases the high net sand areas of greater than 400’. 

 Like many of the net to gross ratio maps the Interval H3-BBS does not show any 

conclusive trends (Fig. 52). There are two low net sand to gross ratio areas in the northwest 

and southwest part of the study. These wells average 0.3 net to gross ratio with higher areas 

in the survey as much as 0.88 in the P.L Rountree #1 in Concordia Parish. This well and the 

two others near it are the only high value net to gross ratio wells. This is to be expected since 

these wells had high thicknesses in the gross interval and net sand maps. The lowest net to 

gross ratio value is in the Humble Tensas Delta #1 with 0.1 net to gross ratio. This 

abnormally low value adjacent to high net to gross ratio values is most easily explained by 

this well being cut by a paleo-channel filled with shale, giving the low net to gross ratio 

value. The average net to gross ratio value throughout this interval in the lower Wilcox 

Group within this study area is 0.46.     

 The net coal map for this interval is very similar to that of Interval H2-H3 except for 

less coal development. The greatest development of coal is concentrated in the north western 

portion of the study area. The Belle Exploration #1 in section 30-7N-4E of LaSalle Parish has 
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a total of 45’ of net coal which is the greatest total thickness found in this interval within this 

study area. Other wells surrounding the Belle Exploration #1 contains values of net coal 

between 9’ and 24’. Coals within this interval are far less laterally extensive than those 

within Interval H2-H3 & Interval H1-H2. The coals within Interval H3-BBS are also 

generally thinner and are more numerous than coals of other intervals of the lower Wilcox.  

The coals of Interval H3-BBS seem to occur along a southwest to northeast trend.  This was 

likely parallel to the orientation of the shoreline when the coal was being laid down in a 

paralic environment. The regions of 0’-10’ in purple on Figure 53 are likely intertidal 

swampy areas where peat accumulation was not consistent through time. Higher 

concentrations of coal likely depict areas of increased topographic relief that were unaffected 

by dynamic coastal processes, giving these locations longer time to accumulate peat.      
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Figure 50. Interval Horizon 3 – Bottom of the Big Shale gross interval map. 
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Figure 51. Interval Horizon 3 – Bottom of the Big Shale net sand map. 
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Figure 52. Interval Horizon 3 – Bottom of the Big Shale net sand to gross interval ratio 

map. 
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Figure 53. Interval Horizon 3 – Horizon Bottom of the Big Shale net coal isochore map. 
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     Interval BBS-TOPW 

 

The Interval BBS-TopW is bound at its base by the Bottom of the Big Shale and its top by 

the Carrizo Sand.  This interval comprises the entire upper Wilcox Group. Out of the 130 

well logs that were selected for this study area, all 130 wells penetrate this interval. This 

interval contains more penetrations than any other interval mapped. Additionally, it is the 

easiest to correlate; being bounded at the Bottom by the Bottom of the Big Shale, which is an 

easily recognized marker and at the top by the Top of the Carrizo Sand, which is similarly 

easy to recognize; throughout the study area, it is the most detailed and accurate interval 

analyzed in this project. 

 The gross interval map of Interval BBS-TopW is very similar in appearance to the 

structure map of the Carrizo Sand (Fig. 54). The well with the thinnest gross section is the 

Placid Oil #2 in LaSalle Parish with 513’. The Moncrief Ducote #1 in the southern portion of 

Avoyelles Parish has a total thickness of 1883’. That is 1370’ of total increase in the upper 

Wilcox from the northernmost well to the southernmost well in the study area. The LaSalle 

Arch is clearly defined by the thin area with less than 1000’ of section overlying it. On the 

flanks of the LaSalle Arch the gross interval map quickly thickens to the west by over 400’ in 

less than 6 miles in some places. On the south and east side of the LaSalle Arch the 

thickening is much more gradual at a rate of about 100’-125’ per 6 miles. On the west, south, 

and east boundaries of the study area, the gross interval thickness is 1500’ or greater.  

 Unlike the gross interval map the net sand map doesn’t have many prominent features 

(Fig. 55).  The most noticeable feature is the high net sand area to the east. The Fife Oil & 

Gas #1 well in Concordia Parish has 1,093’ of net sand. Based on the location and orientation 

of this high net sand belt, it is postulated that it is likely controlled by the Mississippi 
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Embayment. Many of these wells have over 700’ of sand while wells to the immediate west 

have significantly less. The well in the far southwest with over 1000’ of sand is clearly 

anomalous, this well has a different SP scale compared with other wells within the study 

area. The majority of the net sand values display no real pattern and vary between less than 

100’ of net sand and 300’ of net sand.   

 The net to gross ratio map at Interval BBS-TopW is similar to the net sand map, 

toward the east, in defining the high sand area in Catahoula and Concordia Parishes (Fig. 56).  

Many of the wells in this area have net to gross ratio values of over 0.5. Directly in the center 

of the study area is another major sand accumulation. Many of the wells in this area have net 

to gross ratio values of over 0.4. Like previously stated in the net sand map section, the high 

net to gross ratio well in the southwest is anomalous. Petra computes sand footages based on 

normalization of all wells within the project; this wells SP scale falls outside of the range of 

normalization. On the perimeter of the sand accumulation in the center of the study area, 

there are lower net to gross ratio values varying around 0.2.   
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Figure 54. Interval Bottom of the Big Shale – Top of Carrizo Sand gross interval map. 
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Figure 55. Interval Bottom of the Big Shale – Top of Carrizo Sand net sand map. 
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Figure 56. Interval Bottom of the Big Shale – Top of Carrizo Sand net sand to gross 

interval ratio map. 

 

 



    

 92 

     Lower Wilcox 

 

The lower Wilcox Group is bound at its base by the top of the Midway Shale and at its top by 

the Bottom of the Big Shale. The major stratigraphic intervals identified within this study 

area are Interval TopMS-H1, Interval H1-H2, Interval H2-H3, Interval H3-BBS (Fig. 10).  

The three lowermost divisions of the lower Wilcox Group can be seen on well logs as 

coarsening upwards packages followed by a relatively coarse aggradational package.  

Approximately 70 wells in this study area penetrate the entire lower Wilcox Group. 

 The gross interval isochore map (Fig. 57) displays a thin section in the northern part 

of the study area.  The Tensas Delta Land Co #1 has the lowest gross interval thickness out 

of all wells in the study area with 1,538’. The interval thickens by 1,006’ to the south and 

generally thickens to the east and west.  The average gross interval thickness of all wells 

within the Lower Wilcox Group is 2,050’. Towards the south in section 33-3N-3E the Ellis 

Laborde #1 has the thickest gross interval within this study area with 2,543’ of section.  

Other nearby wells have gross interval thicknesses in excess of 2,200’. Generally around the 

perimeter of these thicker wells are wells with lower gross interval thicknesses, ranging from 

1,700’ to 2,000’.     

 The net sand map of the lower Wilcox Group has similar patterns to the gross interval 

map (Fig. 58).  There is a thin area in the northern portion of the study area in LaSalle and 

Catahoula Parishes. Additionally, a thin net sand accumulation is present in the southern 

portion of the study area in Avoyelles Parish. The Moncreif Wright #1 has the lowest net 

sand thickness in the study with 651’. The average net sand thickness within the lower 

Wilcox Group in this study area is approximately 1,155’. The greatest accumulation of net 

sand is in the P.L. Rountree Jr. #1 in section 20-7N-10E of Concordia Parish with 2,102’.  
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The higher net sand areas are concentrated in the center and northeastern portions of the 

study area. 

 As previously stated, many of the features of the gross interval thickness and net sand 

maps carry over to the net sand to gross interval ratio maps (Fig. 59). The lowest net to gross 

ratio value is 0.34 in the Moncreif Wright #1 and the Roy O Martin et al. #1. Generally, wells 

in the central and northeastern portions of the study area have much higher values. The 

average net to gross ratio value within the lower Wilcox Group is 0.56.  The well with the 

greatest proportion of net to gross ratio content within this study area is the P.L. Rountree #1 

with 0.93.   

 Net coal accumulation within the lower Wilcox Group is mostly concentrated in 

LaSalle Parish (Fig. 60). The Mary Pipes et al. #1 in section 19-8N-3E of LaSalle Parish 

contains 94’ of net coal which is the highest amount of coal found within this study area (Fig. 

61). 18 miles to the south the Robert C Jenkins #1 in section 29-5N-2E of Rapides Parish has 

90’ of net coal. Within this study area 86 wells had accumulations of coal within the lower 

Wilcox Group. The average net coal thickness in wells containing coal in the lower Wilcox 

Group within this study area is 17’. South of Township 2N there is no coal accumulation.  

All wells south of this boundary have no lower Wilcox coals and are interpreted as having 

accumulated in marine environments.   
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Figure 57. Lower Wilcox Gross Interval Map. 
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Figure 58. Lower Wilcox Net Sand Map. 
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Figure 59. Lower Wilcox NGR Map. 
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Figure 60. Lower Wilcox Net Coal Map. 
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Figure 61. Cross section D-D’. 
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     Reynolds Coal 

  

The Reynolds coal is found in the Interval H1-H2.  The Reynolds coal, also known as the 

“Big Coal,” is the most laterally extensive and thickest coal throughout northern Louisiana.  

The environment of deposition for the Reynolds coal was in paralic swamps.  Paralic swamps 

pertain to the intertongued marine and continental environments found on the landward side 

of a coast (Encyclopedia of Geomorphology, 2013). The Angelina-Caldwell Flexure defines 

the shelf edge and the shoreline was near the developing flexure throughout the period of 

deposition of the Reynolds coal (Kinsland, 2013). Kinsland (2013) postulated that the 

Reynolds coal was deposited in lagoonal environments possibly behind barrier islands or 

behind other elevated shoreline deposits. The areas in the southeastern portion of the study 

have a sparser well density and most wells do not reach the Reynolds coal horizon.  For this 

reason the Reynolds coal horizon was picked on the coal where it was present and on its 

correlative stratigraphic position in wells where coal is not present. This produces a map that 

shows the anticipated depth of the Reynolds coal throughout the study (Fig. 62). Its 

shallowest penetration in this study is at a depth of -3,354’ and as deep as -11,015’. Unlike 

other sub-regional studies to the north, this study contains far steeper dip to the south in the 

lower Wilcox.  From the most northern point in the study area to the southernmost point 

there is over 6,000’ of relief within all horizons of the lower Wilcox. The Reynolds coal 

demonstrates 7,661’ of structural dip from the Placid Oil #2 well to the Moncreif Ducote #1 

to the south. The structure map at the Reynolds coal is basically identical to the Horizon 1 

structure map. The Reynolds coal is stratigraphically less than 200’ above the Horizon 1 

surface in most wells in the study.  Strong south-southwest dip is seen at the Reynolds coal 

horizon structure map. Dip is gentler near 3500’ to about 6,000’, after 6,000’ dip steepens in 
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the central portion of the study quite rapidly as the result of the nose of the LaSalle Arch. The 

effect of the LaSalle Arch is visible with the increased west and east dip on the flanks of the 

arch. Well penetrations are low toward the west so the arch isn’t defined as well as in the 

western portion of the study area. 

 Unlike the Reynolds coal horizon structure map where the horizon of anticipated coal 

occurrence was mapped, the Reynolds coal isochore is from actual measured coal thickness 

(Fig. 63). The Reynolds coal was deposited in an aggradational shelf margin systems tract 

where the shoreline stayed relatively stable for a period of time sufficient to produce in 

excess of 30 feet of coal just to the north of this study (Kinsland, 2013). Approximately 41 

wells within the study area encountered the Reynolds coal in varying thicknesses. The 

thickest wells are located in the northern limits of the study area in LaSalle and Catahoula 

Parishes. The IPB LLS #1 in LaSalle Parish contains 19’ of coal which is the thickest 

occurrence of Reynolds coal found within the study area. Other nearby wells average 

between 13’ and 17’ of Reynolds coal. The average thickness of Reynolds coal in the lower 

Wilcox is 10’ for wells that encountered Reynolds coal. The southernmost occurrence of 

Reynolds coal is in section 8-3N-2E of Rapides Parish with 8’ of coal.  The Lee Lumber 

Company #2 in section 8 having coal accumulations this far south suggests that this location 

was locally high, aiding in a relatively consistent environment where peat could accumulate, 

decay, and form coal.  Areas in white with 0’ of Reynolds coal are where conditions were not 

suitable for coal development or preservation during this time interval. Since there is no 

Reynolds coal toward the south half of the study area, it should be interpreted that this 

boundary south of Township 3N was the margin of a marine environment (i.e. the shoreline).        
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Figure 62. Reynolds Coal Structure Map. 
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Figure 63. Reynolds Coal Isochore Map. 

  

 

 



    

 103 

     Russell Coal 

 

The Russell coal occurs in Interval H2-H3. The Russell coal is found in accumulations 

parallel to the Angelina-Caldwell Flexure. The Russell coal was deposited in a paralic 

depositional environment (Kinsland, 2013). The Russell coal is generally thinner and less 

prevalent than the Reynolds coal. As previously stated in the Reynolds coal section, many of 

the wells toward the southern portion of the study area do not contain the Russell coal. To 

compensate for this in construction of the structure map, the correlative depositional surface 

has been picked to show the anticipated depth at which the Russell coal would have been 

encountered. Many more wells reached the Russell coal depositional surface than the 

Reynolds coal surface. This produces a structure map with much more well control and an 

overall better structural picture (Fig. 64). The shallowest penetration of the Russell coal in 

this study is at -3,006’. The deepest penetration is at -10,725’. There is a total of 7,719’ of 

structural relief from the northernmost well to the southernmost well. The Russell coal 

mapping surface is less than 100’ above the mapping surface of Horizon 2, and the structures 

of Horizon 2 and the Russell coal are nearly identical. The structure map at the Russell coal 

has contours that are more evenly spaced, better defined structural features, and more 

confident contour positioning than the Reynolds coal structure map. Similar to all lower 

Wilcox horizons, strong south dip is present with the LaSalle Arch creating west and east dip 

on the flanks of the arch.   

 The Russell coal isochore map is very similar in orientation and extent to the 

Reynolds coal isochore (Fig. 65). The Russell coal is not as thick as the Reynolds coal or as 

prevalent with only 32 wells that have an occurrence of Russell coal. The thickest occurrence 

of Russell coal is 13’ seen in three wells the Mamie O Mcgraw #1, Tensas Delta Land Co #1, 
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and the Cotton Estate #1. The average thickness of Russell coal is 8’ in wells that encounter 

it within this study area. The Russell coal is generally thinner than the Reynolds coal, 

possibly because sea level was not stable for as long a period during the transgressive 

systems tract of Interval H2-H3 (Kinsland, 2013).  
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Figure 64. Russell Coal Structure Map. 
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Figure 65. Russell Coal Isochore Map. 
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SUMMARY 

 

     Conclusions 

The purpose of this study was to investigate coal occurrences within the lower Wilcox Group 

in portions of Rapides, Avoyelles, Grant, LaSalle, Concordia, and Catahoula Parishes, 

Louisiana. The depositional systems of the lower Wilcox Group were also evaluated with the 

use of structural maps, gross interval thickness maps, net sand maps and net sand to gross 

interval ratio maps.           

 Coal development in this portion of central Louisiana is rather poor compared with 

areas just north of the study area. However, the best developed coals within the study area are 

situated just south of the Angelina-Caldwell Flexure and on top of the LaSalle Arch. The 

LaSalle Arch was topographically high and, apparently, was a stable environment for paralic 

coal accumulation. This evaluation of this area at the present sub-regional scale with the use 

of more detailed logging suites has uncovered that there are no coals in some areas where 

coals had previously been mapped during the reconnaissance studies. Areas south of 

Township 2N were found to contain no lower Wilcox Group coal accumulation. The area 

south of Township 2N was in a marine environment not suitable for coal accumulation. 

Areas found to contain no coals, where coals were previously mapped, are generally in the 

southern portions of the study area where the high resistivity values previously interpreted to 

be due to coals are likely due to calcareous pelagic sediments.     

 It should be noted that well control within this study area is rather sparse throughout 

when compared with the well density necessary to adequately sample and define the fluvial, 

paralic, and shallow marine sedimentary facies of much of the lower Wilcox Group. This 

should be kept in mind when analyzing the gross interval isochore, net sand, and net sand to 
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gross ratio maps which contain “bullseyes.” These anomalies occur when there are not 

enough data points to define the actual facies distribution. Petra then generates local 

“bullseyes” that are not representative of geological reality.     

 The best developed coals to the north are paralic coals that accumulated in coastal 

marsh environments. The Reynolds coal was deposited in an aggredational shelf margin 

systems tract where the shoreline stayed relatively stable for a period of time sufficient to 

produce in excess of 30 feet of coal just to the north of this study area (Kinsland, 2013). The 

Russell coal is not present as far south as the Reynolds coal development. The Russell coal 

likely did not prograde as far south because the period of time between regressive and 

transgressive systems tracts was too short for adequate coal accumulation. Due to this abrupt 

sea level rise, swamp and marsh environments were limited, reducing the thickness and 

extent of Russell coal compared with the Reynolds coal.     

 Findings support that the St. Landry Canyon is present north of the McCulloh et al. 

(1986) study. The change in structural relief of the Bottom of the Big Shale compared with 

Horizon 3 and the Carrizo Sand suggests an erosional event. The paleo-channel can be seen 

in the Interval H3-BBS net sand map where a 6-8 mile wide section is cutout. These paleo-

channels trend south along the flanks of the LaSalle Arch, likely as a bifurcation into the 

main channel of the St. Landry Canyon. These shale-filled channels are easily compacted 

causing differential compaction and resulting in the increased relief of the Bottom of the Big 

Shale Horizon. 
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RECOMMENDATIONS 

 

This study area would greatly benefit from more detailed work in the shallower intervals of 

the lower Wilcox Group. Horizon 2 and younger intervals should be looked at more 

extensively.  In this study area wells that reach the Midway Shale and see the entire lower 

Wilcox Group were utilized and are much rarer than the quantity of wells which reach the 

depth of Horizon 2. A more detailed study utilizing these additional shallower wells would 

greatly increase the detail and knowledge of the depositional regimes above Horizon 2. 

 This study not only identified coal occurrences of the lower Wilcox Group but also 

found some interesting features within the Interval H3-BBS.  Within the Interval H3-BBS 

large shale intervals within normally more sandy facies are found. These are interpreted to be 

shale filled-channels which are likely submarine canyons. Further research into the location, 

orientation, and causes of these canyons would be a great benefit to understanding the lower 

Wilcox Group in the area. 

Ideally the use of 3-D seismic data in this area would be of great significance. The 

seismic data would allow the user to see large scale structural and stratigraphic features that 

cannot be seen through correlation of widely spaced well logs alone. The 3-D seismic data 

could possibly show paleo-channels, salt diapirs, unconformities, and faults. 

 Core analysis was not used in this study. Subsequent more detailed studies should 

integrate core data into the project to be able to characterize these lower Wilcox Group coals 

better.  Understanding coal properties of the lower Wilcox and being able to describe their 

produciblity and petrophysical data would be a great addition to the coalbed methane 

research group.    
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APPENDIX A: WELL DATA 

UWI/API # 

SERIAL 

# WELLNAME WSN 

SURF 

LONG. 

SURF 

LAT. K.B 

17079203700000 196348 J M HAAS 425 -92.232115 30.969792 78 

17029204000000 125265 C C MILLER 426 -91.642623 31.277674 70 

17009001800000 100128 B QUINN 427 -91.960123 31.105985 54 

17009000600000 61966 P BASCM KELONE ET AL 428 -92.155029 31.142086 66 

17009000780000 37753 JAMES OLIVER UNIT 429 -92.060526 31.175884 87 

17009001290000 72636 ROY O MARTIN ET AL 430 -91.836123 31.22898 53 

17009002100000 103338 SW IMP CO /G/ 431 -91.886723 31.123283 56 

17009002350000 91568 

SOUTHWESTERN 

IMPROVE 432 -91.802222 31.163878 50 

17009201900000 153268 UNA M MOORE 433 -92.084027 31.144486 88 

17009202000000 154890 WRIGHT 434 -92.012921 30.912991 80 

17009202140000 157523 E L LYLES ET AL 435 -92.156427 30.982089 70 

17009202150000 157624 M J DUCOTE 436 -91.985719 30.89879 70 

17009202620000 175012 BROADHEAD 437 -92.089759 31.303671 60 

17009202940000 184398 EMMA MARSHALL 438 -91.793316 31.053999 50 

17009203600000 201188 BROADHEAD 439 -92.011155 31.313464 59 

17009203820000 205757 ED RB SUA;BORDELON E 440 -92.087393 31.162345 87 

17009205480000 217013 BLACK STONE MINERALS 441 -91.779776 31.164246 62 

17009205570000 221373 BLACK STONE 442 -91.791681 31.1509 58 

17009205590000 222532 BLACK STONE 443 -91.749312 31.16898 51 

17025014070000 50885 ROANE B ROBINSON 444 -91.887028 31.419676 60 

17025015330000 36434 LA DELTA HDW LBR COI 445 -91.929527 31.31028 60 

17025205660000 151929 MISSIANA 446 -91.881727 31.390877 49 

17025215330000 208284 MISSIANA 447 -91.895375 31.399939 54 

17029002730000 44160 F D BROWN 448 -91.789527 31.56617 65 

17029013690000 49644 MADISON OIL & DEVELO 449 -91.681822 31.437972 50 

17029013950000 43992 

ANGELINA HARDWOOD 

CO 450 -91.690924 31.399874 60 

17029017690000 80307 

ANGELINA HARDWOOD 

LU 451 -91.699524 31.317776 46 

17029018750000 92970 

ANGELINA LUMBER 

COMP 452 -91.720322 31.273176 53 

17029207330000 137677 ELLIS 453 -91.747223 31.240077 50 

17043004150000 46533 JOE SHORTER 454 -92.604046 31.461776 153 

17043200500000 128508 POLLOCK 455 -92.456241 31.480078 209 

17059026810000 53390 LA DELTA HDW LMBR CO 456 -92.04453 31.430378 54 

17079000310000 64909 ESTELLE H SMITH ET A 457 -92.519541 31.372578 90 

17079000470000 104165 JANIE MOORE ETAL 458 -92.426639 31.426277 167 

17079000480000 72928 

SOUTHEASTERN 

TIMBERL 459 -92.482442 31.411377 129 
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17079000540000 52842 U S A 460 -92.354235 31.421279 85 

17079000550000 70200 L D HATAWAY 461 -92.324736 31.388378 99 

17079004520000 111055 MCGINTY 462 -92.15103 31.346879 64 

17079004680000 86554 ELBERT RYDER 463 -92.175331 31.34938 93 

17079005860000 85045 C O FREEMAN ET AL 464 -92.425935 31.083186 150 

17079202090000 141200 LANGSTON 465 -92.520241 31.150686 186 

17079202630000 161902 HOWARD RYDER 466 -92.176302 31.352893 94 

17079203530000 188402 KEMMONS WILSON ET AL 467 -92.564462 31.072937 213 

17079203860000 207312 VUA;HOLT 468 -92.500793 31.388591 110 

17079204380000 220169 AUS C RA SUB;VANDERL 469 -92.373942 31.01525 95 

17025213990000 202206 WOMACK 470 -91.824207 31.499077 57 

17025215920000 211663 C7 RA SUC; PLACID OI 471 -91.872808 31.464314 63 

17025012980000 26787 TENSAS DELTA 472 -91.968101 31.4815 60 

17025013760000 39343 LA DELTA HDW LBR CO 473 -91.907903 31.3938 54 

17025208000000 168650 MISSIANA 474 -91.868361 31.393916 50 

17025217230000 226866 MISSIANA WL 475 -91.850281 31.281299 52 

17025015570000 36205 LA DELTA HWD LBR CO 476 -91.9674 31.3028 66 

17059027640000 34631 EXXON-TENSAS-DELTA S 477 -92.0151 31.3505 56 

17059205900000 129885 HUMBLE-TENSAS DELTA 478 -92.0503 31.3987 66 

17059248480000 217323 EXXON-TENSAS DELTA 1 479 -92.130097 31.419644 66 

17059204080000 125891 HUMBLE-TENSAS DELTA 480 -92.0907 31.4732 68 

17059203990000 125726 SL 1462 481 -92.1667 31.4881 62 

1705925146000 228489 WX D RC SU117;SL 168 482 -92.108056 31.553056 48 

17059247040000 215489 SL 14382 483 -92.066704 31.537141 78 

17059022410000 112956 BODCAW FEE 484 -92.2054 31.5565 203 

17059233740000 192800 IPB LLS 485 -92.273512 31.553318 68 

17029206640000 135388 WINSTON 486 -91.536 31.5331 76 

17029004380000 33306 FISHER LUMBER CO 487 -91.601413 31.554026 65 

17029222260000 190932 THOMAS NEWMAN ET AL 488 -91.65067 31.521803 65 

17029012580000 112810 RABB SWD 489 -91.710902 31.453598 61 

17029220250000 185909 MADISON OIL & DEVELO 490 -91.664041 31.426931 64 

17029229740000 219669 VUA;MORGAN ET AL 491 -91.51578 31.42035 73 

17029015900000 60477 R B SHARP 492 -91.5215 31.3173 73 

17029017350000 91349 ANGELINA HDW LBR CO 493 -91.6907 31.3572 64 

17029013610000 111801 
ANGELINA LUMBER 

COMP 494 -91.719602 31.371899 49 

17029228660000 214538 ANGELINA BBF 495 -91.772354 31.326482 52 

17029230250000 226102 COX SWD 496 -91.8414 31.308428 62 

17029018000000 82000 YAKEY 497 -91.6909 31.2945 50 

17009002990000 100972 L M HOLMES 498 -91.848603 31.021599 53 
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17009003030000 91401 ROY O MARTIN LUMBER 499 -91.7599 31.0728 60 

17009205560000 221132 BLACK STONE 500 -91.81718 31.15384 68 

17009201370000 138350 R O MARTIN LUMBER CO 501 -91.700288 31.171471 53 

17009001450000 72637 G G SNOWDEN-EL 502 -91.890501 31.207998 57 

17009001190000 46437 FISHER 503 -91.956403 31.1936 57 

17009001760000 103507 B QUINN 504 -91.9688 31.1348 52 

17009002880000 102947 B QUINN 505 -91.973002 31.087599 55 

17009204840000 212195 VUA;W DESCANT 506 -92.10085 31.007234 67 

17009000630000 77817 FLORENCE BERNARD UN 507 -92.139002 31.1145 70 

17009000730000 107722 EDWIN BARBIN 508 -92.0707 31.1529 88 

17009000460000 38419 ELLIS LABORDE 509 -92.163503 31.215398 96 

17009202240000 160712 DUPUY 510 -92.090415 31.250551 80 

17079005770000 44997 C KELLER 511 -92.397502 31.235399 140 

17079005780000 71523 LEE LUMBER CO.  512 -92.285901 31.242998 110 

17079000700000 43198 MARIE BROUSEK 513 -92.3109 31.3076 104 

1707920362000 192863 ALEXANDRIA LBR & LAN 514 -92.340494 31.320478 165 

17009202870000 182715 BROADHEAD 515 -92.106545 31.295332 70 

17043004180000 72891 U S A 72891 516 -92.3758 31.47729 176 

17043004120000 73033 HUGHES USA 517 -92.5305 31.4782 190 

17043003570000 73195 USA 73195 122C 518 -92.6006 31.55419 195 

17079005340000 91082 EOTA REALTY COMPANY 519 -92.1202 31.33509 60 

17079200980000 125104 eota-morace 125104 520 -92.1233 31.34139 59 

17043200390000 127435 POLLOCK 521 -92.4555 31.4656 200 

17079201330000 129006 EDGAR R SLAY ETAL 12 522 -92.2204 31.43969 79 

17043200620000 136996 DUKE ETAL 136996 523 -92.6092 31.55849 194 

17079203000000 172810 MICHEAL WILSON SWD 1 524 -92.1286 31.33542 67 

17043004260000 109101 H N TANNEHILL HEIRS 525 -92.2899 31.48409 83 

17079203340000 181003 JOHN TYLER ET AL 526 -92.12896 31.33221 73 

17079203430000 182874 ELBERT LUCAS 527 -92.13784 31.33201 94 

17079203520000 188263 ROBERT C JENKINS 528 -92.2209 31.39903 84 

17079203740000 198801 MAMIE O MCGRAW 529 -92.21932 31.38506 86 

17079005230000 32883 A N FLOYD 530 -92.1371 31.33489 85 

17079005660000 33181 LESSIE 531 -92.1328 31.32799 94 

17043003580000 43760 TAYLOR 532 -92.5591 31.51409 180 

17079204390000 219410 USA-LROC 34 533 -92.55395 31.10109 255 

17025217160000 225982 TL SU28; ROUTON D 534 -91.818665 31.704214 61 

17025005190000 41857 TENSAS DELTA LAND CO 535 -91.9456 31.6459 51 

17025010110000 106099 BURROUGHS 536 -91.904243 31.609403 64 

17025202160000 128235 T D HOR 537 -91.9293 31.5421 56 
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17025206090000 152618 COTTON ESTATE 538 -91.8168 31.5443 55 

17059242600000 209642 IPB WALKER ET AL ND 539 -92.132107 31.630289 147 

17059251710000 229281 MARY PIPES ET AL 540 -92.202222 31.6625 192 

17059217220000 168739 IPB 1 541 -92.251433 31.706188 121 

17059217710000 170237 IPB 17 542 -92.052835 31.670592 224 

17059018170000 47264 TENSAS DELTA LAND CO 543 -92.0095 31.6195 120 

17059236110000 197548 IPB LLS 544 -92.018309 31.692072 200 

17025015900000 119537 MITCHELL SWD 545 -91.733057 31.649267 63 

17029229010000 215157 VUA;MARY T SMITH ET 546 -91.80944 31.602165 67 

17029221560000 188719 L W MAGOUN 547 -91.731518 31.575436 97 

17029003870000 103450 FISHER LBR CO 548 -91.631233 31.616492 66 

17029000650000 90963 J GLANTON 549 -91.6008 31.663298 65 

17029207870000 140633 J BALFOUR MILLER ET 550 -91.50073 31.702692 64 

17029213540000 163995 L TUSC RA SUG;JOHN D 551 -91.506779 31.664325 65 

17029204590000 126393 LEARNED-PEABODY 552 -91.4383 31.627 64 

17029226920000 209349 P L ROUNTREE 553 -91.47968 31.557949 57 

17029223870000 198470 THOMPSON ET AL 554 -91.636154 31.057237 55 

17079006110000 46964 CROWELL LAND 555 -92.7019 30.956 156 
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APPENDIX B: HORIZON DEPTHS 

WSN SERIAL# WILCOX BBS HOR. 3 HOR. 2 HOR. 1 TOPMS 

425 196348 -8171.8           

426 125265 -4909 -6316.97 -6564.58       

427 100128 -6149.15 -7418.24 -7888.66 -8244.2 -8725.27   

428 61966 -5893.34 -7243.68 -7693.8 -8260.38     

429 37753 -5370.65 -6622.53 -7288.33 -7737.83 -8257.38 -8519.08 

430 72636 -5160.84 -6402.83 -7120.71 -7516.98 -8094.07 -8610.41 

431 103338 -6104.95 -7370.9 -7891.35 -8226.81     

432 91568 -5679.59 -6936.16 -7494.12 -7901.83     

433 153268 -5608.77 -6790.32 -7479.56       

434 154890 -8340.91 -9996.02 -10412.9 -10754.3 -11240.2 -11903.3 

435 157523 -7882.04 -9251.14 -9753.66 -10117.7 -10749.9 -11381.7 

436 157624 -8500.95 -10384.2 -11168.8 -11565     

437 175012 -4183.27 -5242.45 -5720.16 -6288.24 -6843.41 -7467.44 

438 184398 -6702.43 -8068.2 -8811.64       

439 201188 -4235.85 -5225.17 -5617.87 -6191.04 -6720.86 -7321.02 

440 205757 -5478.49 -6730.37 -7382.1 -7803.67     

441 217013 -5671.37 -6942.35 -7716.55 -7982.2 -8578.72 -9225.27 

442 221373 -5797.58 -7079.03 -7662.15 -8095.12 -8688.71   

443 222532 -5641.08 -7016.2 -7741.62 -7966.26 -8585.87 -9301.7 

444 50885 -3897.26 -5051.85 -5585.2 -5903.66 -6359.84   

445 36434 -4492.73 -5571.13 -6293.19 -6626.09 -7202.8 -7737.31 

446 151929 -4102.63 -5216.48 -5891.58       

447 208284 -3996.03 -5117.64 -5722.48 -6185.09 -6697.23   

448 44160 -3625.01 -4645.3 -5003.49 -5407.55 -6182.09 -6722.03 

449 49644 -4408.95 -5575.13 -5904.65 -6260.09     

450 43992 -4469.29 -5744.61 -6222.86 -6681.03 -7366.26   

451 80307 -4816.18 -6166.53 -6593.2 -7059.68 -7683.71 -8195.84 

452 92970 -5069.32 -6548.69 -6876.9 -7220.56 -7869.31 -8344.54 

453 137677 -5131.01 -6654.84 -7217.49 -7587.49 -8103.2   

454 46533 -3274.44 -4634.12 -5281.2 -5821.48 -6182.71 -6662.46 

455 128508 -3268.73 -4654.94 -5239.27       

456 53390 -3326.55 -4282.69 -4944.16 -5376.01 -5754.73   

457 64909 -4007.92 -5325.45 -5991.25       

458 104165 -3635.46 -5098.48 -5684.5       

459 72928 -3790.75 -5087.6 -5867.85 -6271.08     

460 52842 -3740.98 -5114.16 -5747.74       

461 70200 -3848.89 -5348.05 -5846.27       

462 111055 -3672.89 -4629.39 -5182.66 -5665.59 -6251.68 -6743.99 

463 86554 -3672.03 -4694.16 -5097.39 -5727.98 -6239.84 -6720.9 
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464 85045 -6812.72 -8281.2 -8862.19 -9249.76     

465 141200 -5979.64 -7508.16 -8042.67 -8441.97 -8934.91 -9510.23 

466 161902 -3649.1 -4669.72 -5269.87 -5839.53 -6282.81 -7040.25 

467 188402 -6740.34 -8278.24 -8723.66 -9296.45 -9887.93 -10274.8 

468 207312 -3867.05 -5202.3 -5793.07       

469 220169 -7608.54 -9001.08 -9558.57 -9971.64 -10439.4 -11052.9 

470 202206 -3740.85 -4936.47 -5391.27       

471 211663 -3744.23 -4954.57 -5507.18 -5907.46     

472 26787 -3334.38 -4375.86 -4780.41 -5184.95 -5675.56 -6153.27 

473 39343 -3987.66 -5239.54 -5628.71 -6094.71 -6593.94   

474 168650 -4076.06 -5234.17 -5918.72       

475 226866 -4833.63 -5995.62 -6718.48       

476 36205 -4444.58 -5563.53 -6178.95 -6596.4 -7082.71 -7646.49 

477 34631 -3929.4 -4783.4 -5359.45 -5884.58 -6498.8 -7113.02 

478 129885 -3520.27 -4368.85 -5086.03 -5562.42 -6074.34 -6608.53 

479 217323 -3125.2 -4051.67 -4736.1 -5298.1 -5581.89 -6047.45 

480 125891 -2937.46 -3814.24 -4470.66 -4930.16 -5216.17 -5685.04 

481 125726 -2639.53 -3570.64 -4255.99 -4656.63 -5032.41 -5471.82 

482 228489 -2571.73 -3458.28         

483 215489 -2769.82 -3643.46 -4306.22 -4736.27 -5037.17   

484 112956 -2384.46 -3196.31 -4006.49 -4409.91 -4696.48 -5161.1 

485 192800 -2473.28 -3193.25 -3800.18 -4221.54 -4686.33   

486 135388 -4052.8 -5376.96 -5714.55 -6027.54 -7043.58 -7429.25 

487 33306 -3933.04 -5185.03 -5441 -5841.64 -6673.52 -7232.74 

488 190932 -3971.99 -5212.86 -5474.38 -5886.15 -6718.03 -7449.75 

489 112810 -4177.59 -5457.6 -5794.79 -6128.41     

490 185909 -4351.37 -5653.45 -6007.87 -6382.39 -7061.25 -7690.03 

491 219669 -4462.72 -5964.15 -6330.78 -6948.81 -7402.73 -7836.84 

492 60477 -4761.05 -6120.77 -6406.78 -7009.88 -7547.04 -8134.51 

493 91349 -4679.67 -5843.76 -6251.68 -6729.93 -7428.54 -8091.77 

494 111801 -4588.13 -5879.91         

495 214538 -4697.65 -5981.66 -6404.34       

496 226102 -4692.34 -6047.38 -6530.31       

497 82000 -4929.4 -6275.06 -6622.02 -7086.2 -7733.24 -8173.98 

498 100972 -6975.36 -8405.42 -8864.91       

499 91401 -6462.5 -7831.24 -8571.9 -8919.29 -9314.14 -9751.51 

500 221132 -5766.63 -7037.61 -7837.15       

501 138350 -5680.37 -6986.27 -7562.4 -8047.74 -8602.92 -9046.37 

502 72637 -5251.46 -6479.46 -7266.75 -7665.16 -8130.83   

503 46437 -5292.81 -6545.15 -7401.58 -7815.32 -8319.84   

504 103507 -5860.45 -6999.81 -7534.93 -7740.62 -8204.8 -8912.8 
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505 102947 -6331.01 -7601.65 -8089.27       

506 212195 -7439.61 -8799.33 -9252.47 -9732.36     

507 77817 -6190.43 -7591.34 -8149.29 -8774.15     

508 107722 -5580.64 -6851.28 -7193.55 -7592.09 -7995.32 -8632.98 

509 38419 -4977.17 -6168.1 -6733.3 -7399.1 -8087.99 -8560 

510 160712 -4632.14 -5837.14 -6427.92 -6887.41 -7501.63 -8176.8 

511 44997 -5087.07 -6321.03 -6884.09 -7366.61 -8065.23   

512 71523 -4972.55 -6304.25 -6852.72 -7435.13 -7904.65   

513 43198 -4467.48 -5783.01 -6282.01 -6793.55 -7194.86   

514 192863 -4374.21 -5708.04 -6217.83 -6699.68 -7097.8 -7636.92 

515 182715 -4210.78 -5200.1 -5598.64 -6147.22 -6803.64 -7535.07 

516 72891 -3217.93 -4635.56 -5225.38       

517 73033 -3242.34 -4604.1 -5162.78 -5548.97     

518 73195 -2539 -3691.26 -4218.51 -4777.18 -5304.43 -5775.31 

519 91082 -3812.87 -4717.79 -5421.09 -6008.5 -6374.31 -6951 

520 125104 -3762.86 -4671.9 -5145.46 -5681.16 -6296.93 -6785.69 

521 127435 -3375.5 -4744.25 -5376.24 -5774.3     

522 129006 -2973.34 -4114.53 -4708.16 -5196.07 -5518.85 -6112.75 

523 136996 -2484.13 -3646.05 -4204 -4729.14 -5158.2 -5701.09 

524 172810 -3773.05 -4696.72 -5184.4 -5677.01 -6315.87 -6812.33 

525 109101 -2972.24 -3818 -4292.61 -4630.8 -5018.37   

526 181003 -3799.87 -4732.92 -5405.9 -5952.46 -6438.78 -6972.43 

527 182874 -3788.24 -4684.03 -5176.1 -5700.04 -6369.69 -6808.42 

528 188263 -3313.42 -4483.14 -5013.88 -5506.21 -5974.1 -6595.62 

529 198801 -3430.53 -4522.99 -5066.88 -5597.92 -6097.14 -6772.82 

530 32883 -3750.36 -4674.03 -5185.64 -5685.95 -6324.81 -6755.84 

531 33181 -3853.89 -4758.81 -5246.43 -5780.94 -6365.84 -6868.72 

532 43760 -2933.3 -4216.05 -4813.47 -5174.5     

533 219410 -6390.68 -7895.82 -8343.72 -8670.79 -9252.74 -10083.2 

534 225982 -3066.36 -4140.08         

535 41857 -3031.69 -4024.94 -4445.05 -4731.62 -5268.59 -5562.54 

536 106099 -3280.22 -4331.9 -4668.54 -4980.32     

537 128235 -3380.82 -4458.77 -4876.51 -5283.04     

538 152618 -3639.7 -4787.99 -5083.82 -5421.28     

539 209642 -2354.97 -3222.11 -3619.83 -4045.3 -4378.28 -4907.42 

540 229281 -2127.29 -2959.74 -3491.59 -3822.53 -4068.3 -4620.02 

541 168739 -1835.25 -2348.6 -2670.02 -3109.36 -3396.1 -4018.12 

542 170237 -2530.39 -3465.21 -3812.99 -4057.82 -4475.16   

543 47264 -2755.84 -3727.16 -4168.37 -4598.1 -4900.92 -5439.32 

544 197548 -2648.99 -3581.03 -3926.02 -4187.55 -4616.01   

545 119537 -3400.85 -4458.09 -4803.09 -5298.32 -5902.06 -6425.12 
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546 215157 -3458.9 -4527.93         

547 188719 -3657.93 -4739.37 -5108.83 -5482.14 -6313.43 -6852.22 

548 103450 -3709.46 -4780.61 -5228.55 -5629.19 -6288.57 -6856.14 

549 90963 -3576.92 -4684.24 -5126.61 -5521.68 -6206.11 -6648.48 

550 140633 -3452.53 -4291.8 -4741.92 -5210.79 -5928.16   

551 163995             

552 126393 -3696.56 -4754.55 -5102.95 -5463.98 -6415.78 -7039.38 

553 209349 -3937.77 -5053.68 -5377.2 -5806.89 -6615.21 -7323.02 

554 198470 -6424.78 -7757.97 -8286.46 -8784.57 -9288.77 -9841.55 

555 46964 -7796.68 -9193.84 -9619.06 -10111.1 -10712.5 -11672.3 
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APPENDIX C: COAL DEPTHS AND THICKNESSES 

WSN SERIAL# 

TOP 

REYNOLDS 

COAL 

TOP 

RUSSELL 

COAL 

REYNOLDS 

COAL 

GROSS 

RUSSELL 

COAL  

GROSS 

425 196348     0 0 

426 125265   -7084.84 0 0 

427 100128     0 0 

428 61966   -8075.61 0 0 

429 37753 -8203.07 -7542.56 0 0 

430 72636 -7940.23 -7377.24 0 0 

431 103338 -8712.55   0 0 

432 91568   -7778.89   0 

433 153268   -7758.22 0 0 

434 154890 -11015.33 -10725.16 0 0 

435 157523 -10567.42 -10095.6 0 0 

436 157624     0 0 

437 175012 -6709.03 -6122.9   0 

438 184398   -9074.68 0   

439 201188 -6617.29 -6101.65 0 0 

440 205757   -7646.55 0 0 

441 217013 -8497.52 -7938.65 0 0 

442 221373 -8478.88   0 0 

443 222532 -8397.11 -7926.95 0 0 

444 50885 -6320.33 -5844.66 7.99 0 

445 36434 -7026.88 -6538.39 8.94 0 

446 151929     0   

447 208284 -6654.1 -6156.45 7 0 

448 44160 -5830.27 -5372.69 0   

449 49644 -6683.8 -6186.2 5.96 5.96 

450 43992 -7202.42 -6586.61 0 0 

451 80307 -7583.68 -6982.71 0   

452 92970 -7738.34 -7200.72 0 0 

453 137677 -7979.17 -7479.52 0 0 

454 46533 -6035.96 -5751.68 0 0 

455 128508     0 0 

456 53390 -5730.94 -5306.83 12.92 8.7 

457 64909     0 0 

458 104165     0 0 

459 72928   -6209.71 0 0 

460 52842     0   

461 70200     0 0 
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462 111055 -6180.42 -5512.89 9.99 9.99 

463 86554 -6141.84 -5617.78 0 7.23 

464 85045 -9475.48 -9147.08 0 0 

465 141200 -8638.19 -8367.39 0 0 

466 161902 -6170.52 -5698.05 0 10.61 

467 188402   -9212.16 0 0 

468 207312     0 0 

469 220169 -10178.39 -9840.41 0 0 

470 202206         

471 211663   -5860.23 0 0 

472 26787 -5476.67 -5143.55 13 0 

473 39343   -5987.94 0 0 

474 168650     0 0 

475 226866     0 0 

476 36205 -6984.97 -6499 0 0 

477 34631 -6375.45 -5789.32 0 0 

478 129885 -5953.68 -5508.52 0   

479 217323 -5501.1 -5266.07 0 7 

480 125891 -5126.27 -4909.26 8.67 0 

481 125726 -4956.73 -4581.39 15.17 0 

482 228489     0   

483 215489 -4899.56 -4460.66 13 0 

484 112956 -4693.46 -4241.98 8.08 10.48 

485 192800 -4660.45 -4167.75 8.08 4.85 

486 135388 -6812.73 -5977.06 7.45 0 

487 33306 -6448.16 -5746.94 10.53 0 

488 190932 -6348.49 -5786.83 11.92 5.96 

489 112810 -6337.06 -6028.47   7.89 

490 185909 -6883.43 -6296.97 0 0 

491 219669 -7310.01 -6518.16 15.17 11 

492 60477 -7444.96 -6896.1 6.97 8 

493 91349 -7294.87 -6627.72 0 8.67 

494 111801     0 0 

495 214538   -6746.71 0 0 

496 226102     0   

497 82000 -7665.39 -7013.85 0 0 

498 100972     0 0 

499 91401 -9300.72 -8838.31 0 0 

500 221132     0 0 

501 138350 -8489.26 -7999.58 0 0 

502 72637 -8021.55 -7524.45 0 0 
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503 46437 -8189.18 -7709.49 0 0 

504 103507 -8253.86   0 0 

505 102947     0 0 

506 212195 -10300.42 -9684.61 0 0 

507 77817   -8583.92 0 0 

508 107722 -7914.46   0 0 

509 38419 -8049.32 -7329.65 0 0 

510 160712 -7403.99 -6818.87 2.98 0 

511 44997 -7986.77 -7311.61 0 0 

512 71523 -7853.76 -7379.95 8 5.96 

513 43198   -6705.82 0 0 

514 192863 -7035.13 -6612.74 7.81 5.96 

515 182715 -6685.91 -6133.51 9 7 

516 72891   -5475.52 0 7.95 

517 73033   -5499.52 0 0 

518 73195 -5229.83 -4715.48 7.45 0 

519 91082 -6144.45 -5894.63 7.99 4 

520 125104   -5611.97     

521 127435   -5708.39 0   

522 129006 -5436.16   0 0 

523 136996   -4652.72   8.94 

524 172810 -5999.55 -5523.88 13.99 6 

525 109101 -5008.71   8.71   

526 181003 -6117.32   10.52   

527 182874 -5999.91   12.27   

528 188263 -5754.74 -5350.23 10.48 8.38 

529 198801 -5855.77 -5440.89   13.26 

530 32883 -6105.46   9.99   

531 33181         

532 43760   -5142.26 0 5 

533 219410 -9062.18 -8624.47   0 

534 225982         

535 41857 -4981.15   16.15   

536 106099 -5391.39 -4947.15 12.92 9.75 

537 128235 -5534.84 -5161.23 13 6.53 

538 152618   -5334.3 0 13 

539 209642   -4017.91 0 4.33 

540 229281 -3946.9 -3689.2 10.84 8.71 

541 168739 -3354.38 -3006.03 17.42 10.45 

542 170237 -4348.32 -4011.32 13   

543 47264   -4556.34 0 13 
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544 197548 -4479.99 -4168.21 19.39 6.46 

545 119537 -5770.4 -5233.29 9.69 0 

546 215157   -5053.23   0 

547 188719 -5968.79 -5457 7.89 10 

548 103450 -6139.89 -5586.42 0 0 

549 90963 -6093.49 -5501.9 9.99 9.99 

550 140633 -5854.65   7.99   

551 163995         

552 126393 -6308.34 -5448.94 6 6 

553 209349   -5751.23 0 0 

554 198470 -9237.79 -8650.92 0 0 

555 46964     0 0 
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APPENDIX D: LOWER WILCOX INTERVAL NET COAL FOOTAGES 

WSN SERIAL # 

TOP MS- 

HOR.1 

HOR. 1-

HOR. 2  

HOR. 2-

HOR. 3  

HOR 3- 

BBS 

425 196348         

426 125265     8 4 

427 100128 0 0 0 0 

428 61966 0 0 0 0 

429 37753 0 0 0 0 

430 72636 7 0 0 0 

431 103338 0 0 0 0 

432 91568 0 0 0 0 

433 153268 0 0 0 3 

434 154890 0 0 0 0 

435 157523 0 0 0 0 

436 157624     0 0 

437 175012 10 9 0 5 

438 184398 0 0 0 0 

439 201188 0 22 0 0 

440 205757       6 

441 217013 0 0 0 0 

442 221373 0 0 0 0 

443 222532 0 0 0 0 

444 50885 0 0 4 0 

445 36434 0 9 0 10 

446 151929     15 0 

447 208284 0 11 7 0 

448 44160   7 0 2 

449 49644 0 3 0 0 

450 43992 0 4   9 

451 80307 12 9   0 

452 92970 2 0 0 0 

453 137677 0 0 0 0 

454 46533     4 0 

455 128508     6 34 

456 53390 0 16 32 17 

457 64909 0 0 6 19 

458 104165     27 11 

459 72928     38 21 

460 52842     7 5 

461 70200     23 12 

462 111055 0 9 12 0 

463 86554     8   

464 85045 0 0 0 0 

465 141200 0 0 0 1 

466 161902 0 0 5 0 

467 188402 0 0 0 0 

468 207312         
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469 220169 0 0 0 0 

470 202206         

471 211663 0 0 0 16 

472 26787 0 7 4 0 

473 39343 0 0 0   

474 168650     7 0 

475 226866     15 14 

476 36205 0 0 3 5 

477 34631 0 5 0   

478 129885 0 5 9 0 

479 217323 0 0 26 21 

480 125891 0 16 31 24 

481 125726 10 12 0 17 

482 228489       45 

483 215489 0 0 7 9 

484 112956 17 5 41 15 

485 192800 9 25 16 5 

486 135388 6 13 4 5 

487 33306 13 5 0 0 

488 190932 0 12 12 12 

489 112810 0 5 0 0 

490 185909 0 0 9 0 

491 219669 6 18 10 10 

492 60477 5 5 19   

493 91349 5 14   0 

494 111801         

495 214538     6 0 

496 226102     0 6 

497 82000 0 0 0 0 

498 100972         

499 91401 0 0 0 0 

500 221132 0 0 0 0 

501 138350 0 0 0 0 

502 72637 0 0 0 0 

503 46437 0 0 0 0 

504 103507 0 6 0 0 

505 102947     0 0 

506 212195 0 0 0 0 

507 77817 0 0 0 0 

508 107722 0 0 5 0 

509 38419 0   0 0 

510 160712 5 6 4 5 

511 44997 0   5 0 

512 71523 12 9 0 0 

513 43198 0 0 4 0 

514 192863 6 16 19 6 

515 182715 6 10 17 5 

516 72891     12 12 
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517 73033 0 0 12 5 

518 73195 7 7 8 5 

519 91082 0 7 6 10 

520 125104 0 0 0 0 

521 127435 0 4 17 11 

522 129006       0 

523 136996 10 0 17 3 

524 172810 5 11 6   

525 109101   9   0 

526 181003 0 11 7 10 

527 182874 8 11 0 5 

528 188263 0 7 59 24 

529 198801 0 0 9 9 

530 32883 0 6 0 0 

531 33181 0 0 8 0 

532 43760 0 0 9 0 

533 219410 0 0 0 0 

534 225982       7 

535 41857 0 13 0 0 

536 106099 0 21 15 17 

537 128235   19 6 9 

538 152618 0 5 14 0 

539 209642 11 15 22 2 

540 229281 24 20 29 21 

541 168739 0 25 7 0 

542 170237 20 6 0 0 

543 47264   10 22   

544 197548 27 26 15 8 

545 119537 22 4 4 5 

546 215157         

547 188719   5 8 2 

548 103450         

549 90963 11 25 11 6 

550 140633 0 28 12 0 

551 163995         

552 126393 3 9 4 0 

553 209349 4 11 10 3 

554 198470 0 0 0 0 

555 46964         
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APPENDIX E 

A Guideline for Beginning Coalbed Natural Gas Research Projects Using Various 

Software and Research Tools 

 

Completed for Dr. Gary Kinsland 

By: Scott G. Comegys 

September 2006 

(Modified by Adam Kruse) 

TABLE OF CONTENTS 

Introduction 

Chapter 1: Obtaining Well Data from LDWR 

Chapter 2: Using SONRIS (www.sonris.com) 

Chapter 3: Digitizing Raster Images Using Neuralog 

Chapter 4: Creating a Project in Petra 

Chapter 5: Identify Sand and Coalbeds 

The following guideline was completed as part of an independent research project for Dr. 

Kinsland as a means of assisting students in creating projects in PETRA or Kingdom for the 

Coalbed Methane Research Group at the University of Louisiana at Lafayette. The 

information contained herein is a compilation of knowledge gained from the research 

experiences of Gary L. Kinsland, Joshua Kull, Scott G. Comegys, Chris A. Guidry, Eric J. 

Dew, Richard W. Ball, Michael B. Sheahan, William R. Copeland and Dan Han. The 

purpose was to try to expedite the process of surmounting the obstacles commonly 

encountered when trying to learn how to build a project of this kind, especially by those who 

have little or no experience in some of the software suites used at this institution. 

The following workflow has been modified to make it more applicable on a sub-regional 

scale. 
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     Chapter 1: Obtaining Well Data from LDWR 

The first step should be determining the project area. Using latitudes and longitudes, parish 

boundaries, township-ranges, and sections can be used to limit the mapping area. Many wells 

have been digitized from previous projects; when compiling multiple projects be sure that 

each individual project area falls within the bounds of the newly formed project area. 

Next locate the LDWR 2001 (Louisiana Desktop Well Reference) files on one of the CBNG 

group's computers, or the Energy Institutes backup hard drive. Within this file are .dbf files 

that can be opened in Excel. They are database files and they contain all of the information 

used to run the LDWR program. Each .dbf file has a unique parish number, the parish 

number can be found by, SONRIS > Sonris Lite > Codes/Lookups > Parish Information. 

Extract the .dbf files that contain the information needed, e.g. Well data for parishes and land 

grid data (located in Map Data folder). Open the .dbf in Excel for the parish’s wells. Copy 

and paste all of the well information into one large spreadsheet and save as a new file. This 

should produce a very large spreadsheet with all parishes covered in the project. Click on the 

upper-left corner of the spreadsheet to highlight the entire sheet (or press ctrl+a). 

Go to the toolbar and select the following: 

Data > Sort > Latitude > Ascending 

Discard all well information above and below the selected latitude boundaries by 

highlighting the rows (on the left hand side with the row numbers), right clicking, and 

selecting delete.  Now repeat the process for longitude. This produces all well information 

needed for the study area. Wells can also be limited by parish, township, and range. An 

important note: This represents well information that is current up to 2001 only. Further 

researches are needed to get more recent well information. Save the file and then repeat the 
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sorting process by Total Depth to see what depth ranges are in the data. Scroll to the bottom 

of the list and choose the deepest one hundred and fifty wells. This allows getting started 

without getting bogged down with excess searching for logs on SONRIS. However, take note 

of the total depths of these wells, as there is usually a rough correlation between the total 

depth of a well and the depth at which logging starts. While using the deepest wells is the 

best-case scenario, it is important that the wells used have high-quality logs that penetrate the 

interval you are interested in. This will also most likely affect the distribution of wells over 

the project area. 

When completing a sub-regional project, upload all the wells that are in your mapping 

area. You can sort and limit the wells once they are in the Petra project. Having all the 

wells in the project, allows for project goals and objectives to change without having to 

download the data again. 

     Chapter 2: Using SONRIS (www.sonris.com) 

What is SONRIS?  SONRIS is the Louisiana Department of Natural Resources’ Strategic 

Online Natural Resources Information System. It has many uses, but our needs deal primarily 

with the raster log and well information mages. SONRIS Lite Select the SONRIS Lite option 

from the Database Access Menu. The Well Information menu lists various methods to query 

wells. Parish searches may take a while, as all wells within the parish will be listed. Knowing 

the Township/Range or API/Serial Number expedites the process. After the search, a list of 

wells and their info will appear on the screen. Information highlighted in blue is hyper-linked 

to additional information. Document Images Select this tab under the Document Access 

menu on the left hand side, under the Database Access menu. Choose the Office of 

Conservation from the topmost drop down menu. At the bottom of the information menu is 
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an entry space for Serial Number (SN). I recommend using this search method. Enter SN and 

left click the Execute Search icon. Pressing enter will not automatically initiate the search. In 

the lower left screen some tabs will show up: They will list office and document type. Well 

logs will be labeled by log type and scale. There will be other information files as well. Well 

files have also been scanned. These images can be opened directly from the link and may 

contain information on tops, elevations, etc. Tops information is located on the back (second 

scanned image) of completion reports at the bottom. In uncertain areas, completion reports 

will be a valuable asset. For logs: scroll to the right side of the screen, right click on the 

Download tab and then save file as. The file must be saved as a .tif image to be recognized. 

Opening the file directly and then saving it through the Panagon viewer will not be 

recognized. Save the file by the API (all previous projects have logs saved as API). 

Sometimes there are different log types available. They differ by log type, scale, etc. 

Differentiate these in the file names, for example: 123456_BHC, 123456_DIL_2 in; file 

names can be long or short, so try to keep them easy to read and uniform. Digitize as many 

logs as possible (porosity, SP, GR, ILD, SN) because the more logs available in the project 

will make it easier in identifying coals in the project. Open the logs in Neuralog, PETRA, or 

the viewer, and figure out what curves are on the log, how deep the curves are, log quality, 

etc. Consider getting one log in at a time and then digitizing the curves, or doing them all 

together.  SONRIS can be temperamental, it is recommended that you:evaluate which logs 

are of good quality and useful, and download them immediately. Tip: It is better to have an 

extra log downloaded to fall back on, rather than no log at all. 

With all of the well information and log images a project can be constructed GIS 

SONRIS also has a GIS application that can be used if desired; there is an online tutorial that 
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explains the program in detail. There is an option to view USGS topographic maps as a layer, 

and this should be used when no elevation information is available in well files or on the 

logs. Since LDWR contains only wells available in 2001, you can search for updated logs in 

your mapping area. Many wells are on the GIS maps however; many wells do not have their 

associated raster logs. To access numerous well files from GIS interactive maps: 

Interactive Maps > Use zoom tool to zoom to area of interest 

(must be zoomed in enough to show well locations) > Turn on Oil/Gas 

Wells > Highlight Oil/Gas Wells > Click the Identify tool > Identify by rectangle tool > 

Select area of interest 

A window will pop up with all the wells in selected area with well information (there 

can be hundreds of wells in a selected area, therefore a smaller area is easier to deal with and 

a less likelihood of crashing). This information can then be input in the Document Image 

search. This will allow for a large search of logs in a relatively short amount of time. 

     Chapter 3: Digitizing Raster Images Using Neuralog 

Open the Neuralog and create a new project. Begin by opening a log image that 

was downloaded from SONRIS. File >Open > Log Image > Link to new project 

It is important to have all the well header information in the new digitized format. 

Edit > Well log Properties Input all pertinent information from well log header (i.e. API, 

Kelly Bushing, etc.).  The first step in digitizing it setting up the depth and scale axis.  Click 

the Create Scales and Depth Axis button > On the left side of the depth track, click once and 

assign proper depth value > Go to bottom of well and assign the lowest depth of interest > 

Press the Create scales and Depth axis button again, this will make the crosshair red, assign 

left side value first, then right side > Horizontal button allows for horizontal scale to be 
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assigned, right clicking allows for the computer to make picks (the better the logs, the better 

the computer does at picking the scales) (Tip: It is not necessary to assign a depth scale by 10 

foot interval. Every 50 foot will suffice. > Vertical scale must be assigned, similar to 

horizontal, right clicking will allow computer to pick scale locations > Most logs were not 

scanned perfectly straight, so one must adjust the scales sothey follow the log most 

accurately. After both the horizontal and vertical scales are assigned, click the Edit depth or 

Scale Axis button > Adjustments to the depth scale can be made while going up the log > 

When finished straightening the log scales, click the digitize curve button , a pop-up will ask 

what kind of curve is being digitized > The computer has different functions that allow 

picking of the curve easier, choose tracer type , right click and the computer will follow the 

curve (again, the better the quality of the log, the better the computer will do) > This process 

will be repeated for each curve , there may be multiple curves on a single depth/scale axis, in 

which a single depth axis would be acceptable (resistivity logs for example) > When all 

curves are completed, File >Export Digital Logs > Select all curves, Preserve Peaks, Smooth 

outputs, View After generation, add formatting information> OK > View and check log for 

errors (i.e. missing sections, scales off, etc...) Save digital logs as the API number (ex. 

17059237760000.las). This allows importing the files as single wells, or in groups. All 

previous projects have .las files in the same format.  Since some of the SP curve only has the 

interval value, the maximum and minimum value should be set up carefully with count the 

interval values. It doesn’t matter, if all the SP curves have the same range of max and min, all 

the curves will be normalized after imported in PETRA. 
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      Chapter 4: Creating a Project in Petra 

Open the program, choose a name, and save the project.  Do not share it or connect it to 

another project.  In the following discussion, terminology will be used that is unfamiliar to 

first time users of PETRA. The program offers a built in tutorial and covers the basics 

in detail (see PETRA manual in Sandstone or the Basic Training Class Workbook).  The 

PETRA training manual is online at: ftp://ftp.rac.louisiana.edu/upload/EI/coalbed methane 

/articles/Choose a map projection Project > Settings > Set Map Projection > Custom 

Projection tab: Lambert Conformal Conic Ellipsoid: Clarke 1866 State Plane: Louisiana 

North (NAD 1927) Set Datum as NAD 1927 (North American Datum) Bring in Base Map 

The coalbed methane group has provided a basemap as a PETRA overlay (.ovl) file. Obtain 

this from the group folder at the ftp site and select (in the map module) Overlay > Load > 

Overlay file Follow the instructions below to build a landgrid from LDWR 2001 from 

scratch or scroll down to the instructions for bringing in township/range lines. The section 

lines and labels are already included in the coalbed methane land grid. 

Go into the Map Module 

Overlay > Load > Import 

Under File tab: 

Browse for the shape file from LDWR 

Merge with the current layer 

File Type: ESRI Shape File (LAT LON) 

Load Into Layer: LANDGRID 

Import > OK 

Start with the entire state. If it does not appear after selecting OK, 



    

 137 

go to Display > Data Limits > Use Overlay Extents. 

Repeat the process for Section, TWP & RGE. 

Each parameter, i.e. section lines, imported into the program can be located in its own layer. 

This enables the user to turn different layers off and on and is helpful when making various 

maps.Return to the Main Module Before importing well data that was created in Chapter 1, a 

couple of more things need to be done: 

Save the spreadsheet as a CSV (Comma Delimited) in Excel. 

Project > Import > General Well Data From > Generic ASCII file 

Import File > Browse for file 

Data Format Select UWI or API Number from upper-right pull down menu.  Highlight the 

API number in the topmost row and click the + symbol.  Repeat the process for all of the 

columns, but DO NOT highlight the commas. Bring in LAT/LONG and let PETRA calculate 

X/Y values automatically. Also, PETRA will automatically determine parish and state from 

the API number (Wells > Set State/Cty from API Number).  Skip rows that have column 

titles in them.  Import .las files into project. This is accomplished in the main module Logs > 

Import Las file, or Logs > Batch las import. It will be beneficial to upload the raster images 

as well. Some detail is lost in the digitizing process it is sometimes necessary to view the 

original raster image. To batch upload the raster images, Project> Import> Raster Logs 

From> Uncalibrated TIFF Files. 
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     Chapter 5: Identify Sand and Coalbeds 

Previous coalbed natural gas work at the University of Louisiana Energy Institute 

involved using a resistivity cutoff value to define coals, known as the Quick-Look 

Technique (Kull, 2006). When mapping smaller areas with more well control, one must 

use a more precise way of defining coal beds. This will be done by examining individual 

logs in cross section and using as many curves as possible to identify coal beds.  Digitized 

logs may have different curve names for similar measurements, e.g., ILD, LN, AITH are all 

electrical resistivity records measured by different tools. PETRA has a feature that allows the 

user to alias logs of similar nature under a single curve title. For example, all of the long 

resistivity curves mentioned above may be grouped as Res_Long and the short resistivity can 

be grouped as Res_Short. 

STEP 1: Normalize SP (Main Module) 

Compute > From Logs > Normalization 

Normalization makes all the logs have the same scale. Petra only allows one scale 

for each kind of log. SP logs come in many different scales; therefore it will make correlation 

much easier when all the SP logs have the same scale. One should try different types of 

normalization and see which one yields the best results. Do not normalize resistivity logs, as 

most, if not all are already the same scale, 0 -10 ohms. 

In the Crosssection and Log correlation Module, SP logs can be displayed in color 

intervals to depict interpretation as sand or shale. The ILD curve can be done as the same 

way.  Logs > Scales and Display Options > GeoColumn > Colors The colors can be manually 

chosen or automatically interpolated. After the log curves display in the cross section, some 

curves will have a problem with the color interpretations. In order to prevent this problem, 
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try to use logs that, before normalization, had the same scale and were taken by the same 

well logging company. If this is not possible, for the individual curve, the normalization 

should be applied again by changing the mean value of the curve. 

STEP 2: Create Formation Tops (Main Module) 

Before correlating the formation tops in the cross section module, the formation tops must be 

created. Fm Tops tab > + New Top > Type in the Formation Top name, for example: 

"Carrizo" > OK 

Repeat this for all remaining Formation Top in the project. 

STEP 3: Create a Zone (Main Module) 

Zones > Add/Modify (Zone Maintenance) > New Zone Interval Definition 

Upper Depth = Wilcox 

Lower Depth = Midway 

Create zones for each interval to be interpreted. I recommend creating zones for each zone of 

the Lower Wilcox. To do this, the upper and lower boundaries (tops) of the interval must be 

determined, i.e. BS, 3, 2, 1, MY. 

STEP 4: Correlate Formation Tops (Cross Section Module) 

To select the wells needing correlation: 

Wells > Select Wells > Wells From A List > Select Wells from Available Wells > Accept... 

To correlate Formation Tops for the wells: Choose a given "Top" from the "Tops" drop down 

menu > Start > Left click on the log to pick the Top > to finish picking Tops, right click.  

Only after all Formation Tops are correlated correctly, can you move on to"Computing Log 

Statistics" and "Computing Net Footages," for each new correlation will call for new 

computations of Log Statistics and Footages. 
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STEP 5: Creating Maps (Map Module) 

Click on the "Create a Grid" button > Data > Zone Data To Grid > Choose Zone to Grid > 

Choose Zone Data > OK 

Click on the "Contour o Grid" button > Grid > Choose Grid to Contour from drop 

down menu > OK 

STEP 5: Compute Log Statistics (Main Module) 

Compute > from logs > Statistics 

Select log data from > SPSelect: Mean, Percentile N = (ex. 5 & 95) 

Compute for Zones > Zone of Interest 

Experiment with different percentile ranges. The ultimate goal is to view the histograms and 

see how the mean plots, i.e. does it capture the thin, or less prominent sands? Go into 

Histogram Module and view histograms for wells. 

Depths > Depths tab > Select Zone 

Return to Main Module: Compute > from Zones > Equation Expression 

Transform: SPCUTOFF = (PC5SP + PC95SP)/2 

Assign Z Data: 

Output Zone: Zone of Interest 

Equation Variables: PC5SP _ Zone > Wilcox > PC95SP 

> Assign 

Repeat for PC95SP 

In Histogram Module: 

Define Picks > Choose Zone > 5th/95th percentiles, mean, cutoff 

Repeat for each zone. 
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STEP 6: Compute Net Footages 

Compute > from logs > footages 

Footages: 

Check: Gross, Net, Net/Gross 

Log Curves & Conditions 

Gamma Ray 

SP 

Min Cutoff = -1000 (this makes sure all SP values 

are included, Max = mean). 

Depth Zones > Zone of Interest 

Options: Gross is Interval Thickness only. Compute for all selected wells. This will process 

all of the wells selected in the Main Module. 

Filter: Check tops, use interval. In order to save time you can batch process your calculations. 

Simply enter your settings (carefully) for every calculation you want to complete, and choose 

a single interval. Verify the upper and lower tops in the “Filter” tab bind the interval you 

picked. Save each template (this includes zone and interval calculations automatically) as 

specific file names (Ex. 3-2 Interval Net Sand Calculation). Once you have saved a template 

for the entire interval and calculations you want to run go to the “Batch” tab.  Click the < 

button and enter all of the file names by clicking on them, when finished click open. This 

will add all of the selected files to the batch process menu. To finish click “Process Batch 

Template”. 
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STEP 7: Identify Coal 

The Quick-Look Technique utilized only the ILD logs using a cutoff value where any 

amount greater than the cutoff value is defined as coal. This method is not very specific and 

should not be applied to a smaller detailed mapping area. Ideally a suite of logs (porosity, 

gamma ray, electrical) will be available for every well, however that is not the case since 

most of the wells come from SONRIS. There are still a number of wells that have many logs 

available, and these wells should be examined first. Coal beds have a unique signature, low 

GR, low density, high resistivity and high transit time. Therefore, if you have all of these 

different kinds of logs it will be more accurate than using just the resistivity.  Coals should be 

identified as a spike in resistivity. It turns out to be a spike due to the high resistivity and 

rather thin beds, typically less than 12 feet. Certain parameters can be set up in Petra so that 

where curves cross there is coal (i.e. resistivity crosses porosity curve). To make this 

worthwhile one must have a large number of wells with all the same kind of porosity logs. 

STEP 8: Picking Coals 

Petra has a tool to pick pay in the cross section module in which can be used to pick coalbeds 

as well. Use the Pay Intervals toolbar: Begin by selecting the New Pay Name and assigning a 

name to the coalbeds in the interval of interest. A different "Pay" is to be assigned to each 

individual interval, similar to what has been done in the previous CBNG theses. There should 

be four different pay zones, each associated with an interval. A different color for each pay 

zone makes it easier to identify and correlate. Below are the established intervals, pay zone 

names, and associated colors: 

Interval Horizons Pay Name Color 

1 MY-1 Coal_A Black 
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2 1-2 Coal_B Blue 

3 2-3 Coal_C Magenta 

4 3-BS Coal_D Light Green 

Once the four pay intervals have been created, pick the top and base of each coal bed can 

begin. Picking pay intervals is performed by using the Pay Interval tool, , which ensures the 

correct coal is selected for the proper interval. When all the coal has been picked for a 

selected interval, right click and save to database. When all the coal beds have been selected 

for their proper interval, use the summation tool to add the footage to the database. Make 

sure that the pay is being summed into the correct zone and in the correct item. A new item 

will have to be created for the interval, such as NET_COAL_A for the deepest interval.  This 

can be done in the main module, Zones (tab) > Maintenance > Select Zone of interest > Data 

Items (tab) > + New Item 

Now that the wells have the coalbeds selected and summed for each interval, the 

whole lower Wilcox can be summed in the main module. Create a new zone item in the 

Wilcox-Midway zone and name it Net_Coal_Picks. Once the Net_Coal_Picks has been 

created, all the different zones can be summed into that item by the following,  

Compute > From Zones > Summation > Z Items to Sum... 

Select all the summed coal values and store results in the Wilcox-Midway Zone. 

Step 9: Exporting Figures: The following steps must be followed to export maps and cross 

sections from Petra to other p   Map Module/Cross Section 

Module > File > Print Preview > XPS 

Document Writer > OK > Set Legend Parameters > OK > Save as a .xps file > File > Save 

As > .jpeg file 
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